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ABSTRACT 

With the advent of horizontal drilling and hydraulic fracturing in the 

Midcontinent, U.S.A., fields once thought to be exhausted are now experiencing 

renewed exploitation.  However, traditional Midcontinent seismic analysis 

techniques no longer provide satisfactory reservoir characterization for these 

plays; new seismic analysis methods are needed to properly characterize these 

radically innovative play concepts.  Prestack impedance inversion correlated 

with surface seismic attributes and well log measurements from within the 

bounds of the 3D seismic survey maps tripolitic high-porosity chert sweet spots 

within a highly fractured Mississippian limestone reservoir. 

A raw 3D prestack seismic survey from Osage County, Oklahoma, 

U.S.A., is reprocessed with the goal of performing a prestack time migration.  

Time processing and filtering is applied, paying careful attention to velocity 

analysis and coherent noise filtering.  The use of a robust prestack structure-

oriented filter and spectral whitening greatly enhances the results.  Prestack 

time migration is applied using an azimuthally binned Kirchhoff algorithm, which 

allows for better imaging of subtle discontinuities in an otherwise mostly flat 

terrain.  Migration stretch is then corrected by removing the normal moveout, 

picking new velocities, applying a new normal moveout correction, followed by a 

final prestack structure-oriented filter and spectral whitening. 

Using the reprocessed and prestack time-migrated seismic data along 

with a well from within the survey bounds, P- and S-Impedance, density, P- and 

S-wave, Lambda-Rho (λρ), Mu-Rho (λρ), and VP/VS ratio volumes are 



xxii 

generated using simultaneous prestack inversion.  Additionally, surface seismic 

attributes are generated to aid interpretation of the seismic data.  Seismic 

attributes such as prestack impedance inversion are sensitive to lithology while 

coherence and curvature are sensitive to lateral changes in waveform and 

structure.  These attributes are used in conjunction with interpreted horizontal 

image logs to identify zones of high porosity and high fracture density.  

Calibrating the results to well logs helps improve the understanding of the 

seismic behavior of highly porous tripolitic chert, aiding the proper 

characterization of this complex Mississippian carbonate reservoir play. 
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CHAPTER 1: INTRODUCTION 

Osage County (Figure 1) is home to the Osage Indian Reservation and is 

located in northeastern Oklahoma, sharing a northern border with the 

Oklahoma-Kansas state line.  Osage County has an extensive history of 

hydrocarbon exploration and production.  In 1896, Osage County’s first well 

was drilled with oil discovery occurring a year and two wells later (Bass, 1942).  

There are currently over 17,000 vertical wells in place from decades of 

conventional exploration and production (Walton, 2011).  The fractured and 

highly porous Osagean tripolitic chert is the formation of interest with a target 

depth of 2,900-5,000 ft (880-1500 m).  Recently, interest in the Mississippian 

Lime play has renewed with the utilization of horizontal drilling and hydraulic 

fracturing techniques, making it a “hot” resource play. 
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Figure 1: Map showing location of Osage County, Oklahoma, outlined in red.  
The blue box in the northwestern portion of the county shows the study area’s 
approximate bounds (modified from OGS OK counties map and University of 
Texas Libraries PCL map collection).  
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The Mississippian Lime of northern Oklahoma consists of a tight highly 

fractured limestone, fractured nonporous chert, and a highly porous (20-50%) 

diagenetically altered chert called tripolite.  The tripolite itself is discontinuous 

and occurs in pockets with varying thickness, making the tripolite a challenge to 

map. 

The play concept is to drill horizontal wells perpendicular to the fractures 

in the lime and nonporous chert and then increase the number of migration 

pathways by hydraulically fracturing and/or acidizing the formation in order to 

produce from multiple tripolitic chert “sweet spots”. 

Seismic imaging of Mississippi Lime presents several challenges.  First, 

the target in Osage County is shallow (t=530 ms, z=2900 ft) giving rise to 

significant acquisition footprint.  Second, the tripolite is a diagenetic product and 

may not exhibit the same lateral continuity as the unaltered limestones.  Third, 

natural fractures and joints are critical to the orientation of horizontal wells, 

requiring azimuthal velocity (VVAz) or amplitude (AVAz) analysis.  Finally, 

optimal placement of horizontal wells requires high vertical resolution and the 

lateral resolution of potential geohazards. 

Relatively little has been published on the Mississippian Lime play.  

Rogers (1996, 2001) presents a study and model for the diagenesis and 

deposition of the Mississippian chert in Kay County, Oklahoma, directly to the 

west of Osage County.  Watney et al. (2001) characterize the Mississippian 

chert in south-central Kansas and describe the paleo-shelf carbonate system 

that existed during the Mississippian.  Nissen et al. (2006) describe the 
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application of seismic attributes for fracture trend detection to Mississippian 

carbonate reservoirs in Kansas.  Angelo (2010) uses Gray Level Co-

Occurrence Matrix (GLCM) seismic texture attributes and self-organizing maps 

(SOM) to map subtle, thin-bed channels using seismic data from Osage 

County, Oklahoma.  Yenugu et al. (2010, 2011) present a study of Osage 

County Mississippian chert reservoir property prediction using GLCM seismic 

texture analysis and AVO inversion correlated with observed well log properties.  

Yenugu and Marfurt (2011) present a correlation of seismic curvature with 

fractures observed on borehole image logs.  Elebiju et al. (2011) study the 

basement structures of Osage County using seismic attributes and gravimetric 

data, concluding that basement deformation trends may control Mississippian 

chert deposition.  Matos et al. (2011) use GLCM seismic texture analysis and 

Kohonen SOM to map chert facies in an Osage County study area.  Zhao 

(2011) studies the petrologic and petrophysical characteristics of Mississippian 

chert and limestone using core and well logs from a well in Osage County and 

in Pawnee county just south of Osage County.  Dowdell et al. (2012) present a 

study of a Mississippian tripolitic chert reservoir in Osage County using 

poststack acoustic impedance inversion, surface seismic attributes, well logs, 

and supervised and unsupervised 3D seismic facies analysis.  Farzaneh (2012) 

presents an integrated paleomagnetic and diagenetic study to determine the 

origin and timing of diagenetic events for Mississippian limestones in northern 

Oklahoma.  White et al. (2012) interprets natural fractures observed on 

horizontal borehole image logs and correlates the fractures to surface seismic 
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attributes to study the stresses and deformation of Osage County Mississippian 

limestones.  Roy et al. (2012) uses supervised and unsupervised 3D seismic 

facies analysis to classify petrofacies within a Mississippi Lime reservoir located 

in Osage County. 

I hypothesize that prestack impedance inversion of a 3D seismic 

prestack survey will allow me to successfully map zones of varying lithology.  

Due to the different petrophysical nature of the tripolite in comparison to the 

other carbonate and chert facies present in the study area, I believe that 

pockets of tripolitic chert can be identified using prestack impedance inversion.  

Additionally, I assert that when coupled with post stack seismic attributes such 

as coherence and curvature and with interpreted horizontal borehole image logs 

I will be able to map potential tripolitic chert “sweet spots” consisting of high 

porosity (low impedance values) and high fracture density. 

I begin with an overview of the geology of the play in Chapter 2.  Next, in 

Chapter 3, I discuss processing a 3D prestack seismic data to improve the 

spectral content and suppress groundroll.  In Chapter 4 I discuss the 

petrophysical properties of the various facies encountered in the Mississippian 

Lime and show the results of simultaneous prestack impedance inversion and 

Lambda-Rho/Mu-Rho (LMR) inversion.  I then use the inversion attributes and 

surface seismic attributes to map lithology and porosity, focused primarily on 

mapping tripolite.  In Chapter 5 I present my conclusions, which I then follow 

with an in-depth discussion of my prestack time processing in Appendix A.  

Figure 2 summarizes my workflow for this thesis.  
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Figure 2: Summary of the thesis workflow. 
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CHAPTER 2: GEOLOGIC BACKGROUND 

REGIONAL 

Oklahoma’s sedimentary rocks are mostly marine in origin, with 

thickness ranging between 6,000-12,000 m (20,000-40,000 ft) in the major 

basins and 0-3,000 m (0-10,000 ft) over the uplifts (Johnson and Cardott, 

1992).  Precambrian granites and rhyolites make up the majority of Oklahoma’s 

basement rocks (Johnson and Cardott, 1992).  Thick sequences of marine 

carbonates, typically deposited in warm, aerated, and shallow waters, are 

characteristic of Upper Cambrian through Mississippian strata, interbedded with 

thin sandstones and shales (Johnson and Cardott, 1992).  Shales such as the 

Upper Devonian-Lower Mississippian Woodford Shale were deposited in 

anaerobic marine environments, where conditions were favorable for 

preservation of organic matter (Johnson and Cardott, 1992).  Pennsylvanian 

strata consist of marine and nonmarine shale, sandstone, conglomerate, and 

limestone, while Permian and post-Permian sediments consist largely of red 

bed and evaporite deposits and terrestrial sediments (Johnson and Cardott, 

1992). 

Three major tectonic/depositional provinces existed in Oklahoma at the 

onset of the early Paleozoic (Johnson and Cardott, 1992).  Figure 3 shows the 

extent of the Oklahoma Basin, the southern Oklahoma aulacogen, and the 

Ouachita trough. 
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Figure 3: Major Oklahoma tectonic/depositional structures present during the 
early Paleozoic (Johnson and Cardott, 1992).  
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The Oklahoma Basin was a broad, shelf-like area where thick and extensive 

shallow-marine carbonates were deposited along with interbedded marine 

shales and sandstones (Johnson and Cardott, 1992).  The southern Oklahoma 

aulacogen was a west-northwest trending trough and was the depocenter for 

the Oklahoma Basin (Johnson and Cardott, 1992).  The Ouachita trough formed 

as a rift at the southern margin of the North American craton and was host to 

deep-water sediments (Johnson and Cardott, 1992). 

During the Pennsylvanian, sharply uplifted crustal blocks divided the 

Oklahoma Basin and southern Oklahoma aulacogen into several well-defined 

marine basins (Johnson and Cardott, 1992).  A Late Mississippian-Early 

Pennsylvanian epeirogenic uplift and erosion resulted in a widespread pre-

Pennsylvanian unconformity (Johnson and Cardott, 1992).  Continued orogenic 

pulses in the aulacogen and the Ouachita trough resulted in the Ouachita fold 

belt, the Wichita, Nemaha, Arbuckle, Ozark, and Criner uplifts, and intense 

downwarping of the Anadarko, Ardmore, Arkoma, Hollis, and Marietta basins 

(Johnson and Cardott, 1992).  Figure 4 shows the major geologic provinces of 

Oklahoma that resulted from this series of orogenic events.  Except for in the 

Ouachita province, early and middle Paleozoic sediments are quite laterally 

extensive throughout the state.  Figure 5 shows a generalized rock unit 

correlation chart, while Figure 6 shows a generalized correlation chart for 

Mississippian stratigraphic units (Johnson and Cardott, 1992; Northcutt et al., 

2001).  
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Figure 4: Major geologic provinces of Oklahoma, with Osage County outlined in 
red and the study area represented by a blue box (modified from Johnson and 
Cardott, 1992).  
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Figure 5: Generalized correlation of rock units in Oklahoma (Johnson and 
Cardott, 1992). 
  



12 

 
Figure 6: Correlation of Mississippian stratigraphic units in the southern 
Midcontinent.  Osage County is located on the Cherokee Platform (Northcutt et 
al., 2001).  
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LOCALE 

Osage County is located on the Cherokee Platform, bounded by the 

Nemaha uplift to the west and the Ozark uplift to the east (Johnson, 2008).  The 

county is an area of low relief with exposures of Pennsylvanian shale, 

sandstone, and limestone throughout, dipping regionally to the west by 1°-2° 

(Thorman and Hibpshman, 1979).  Figure 7a is a paleogeographic map 

showing the location of Oklahoma during the Mississippian (Blakey, 2011).  The 

Mississippian occurred approximately 359 to 318 Ma and comprises 

approximately the lower two-thirds of the Carboniferous.  A warm, shallow sea 

with plentiful marine life covered most of Oklahoma during the Mississippian 

(Rogers, 2001).  Carbonate deposition occurred primarily during the Osagean, 

Meramecian, and Chesterian intervals of the Mississippian as slope and ramp 

margin banks with an extensive shelf margin, shown in Figure 7b, trending east-

west along the Oklahoma-Kansas border (Watney et al., 2001). 
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Figure 7: (a) Paleogeographic map showing the location of Oklahoma (red) 
during the middle Mississippian (modified from Blakey, 2011). (b) Extent of the 
Burlington shelf in Oklahoma during the Mississippian (Watney et al., 2001). 
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Figure 8 presents a generalized stratigraphic column for Osage County 

from Elebiju et al., (2011) based on the work of Zeller (1968), Thorman and 

Hibpshman (1979), and Franseen et al. (2004).  Precambrian basement rocks 

underlie the entirety of Osage County and include the Washington County 

volcanic group, Spavinaw granite group, Osage County microgranite, and the 

Central Oklahoma granite group (Thorman and Hibpshman, 1979).  The 

Precambrian basement surface is an irregular erosional feature with a broad 

westerly slope and a northwest trending series of domes extending from Tulsa 

across the county (Thorman and Hibpshman, 1979). 

Paleozoic sediments overlie the Precambrian basement, recording four 

marine transgressions and regressions across the region from south to north, 

and there is almost no record of Mesozoic or Cenozoic deposition, save a few 

late Cenozoic deposits related to Pleistocene glaciation (Thorman and 

Hibpshman, 1979).  Regional unconformities mark times of widespread non-

deposition and/or erosion between each of these marine 

transgression/regression sequences (Thorman and Hibpshman, 1979).  In this 

manner, it is possible to have relatively young rocks deposited on much older 

rocks with no record between (Thorman and Hibpshman, 1979). 

Cambrian granite wash and the Reagan Sandstone were deposited 

unconformably on top of the Precambrian basement.  While the granite wash is 

local in distribution and likely the result of reworked lag gravel deposits, the 

Reagan Sandstone represents a more continuous basal Paleozoic layer and is 
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a fine, well-sorted rock ranging in age from Late Cambrian to Early Ordovician 

(Thorman and Hibpshman, 1979). 

The Arbuckle Group, consisting of interbedded siliceous limestone, 

dolomite, and sandstone units, ranges in age from Late Cambrian to Early 

Ordovician and lies unconformably on the Reagan Sandstone (Thorman and 

Hibpshman, 1979).  Precambrian highs were not completely covered by 

Arbuckle Group strata until the Lower Ordovician, and subsequent post-

Arbuckle erosion uncovered some of the Precambrian highs (Thorman and 

Hibpshman, 1979). 

The Simpson Group is Middle Ordovician in age and is the only unit of 

Middle Ordovician-Lower Devonian age present in Osage County (Thorman 

and Hibpshman 1979).  The group is composed of a basal sandstone (Burgen 

Sand), a middle green shale and sandstone with local dolomite (Tyner 

Formation), and an upper sandstone (Wilcox Sand; Thorman and Hibpshman, 

1979).  During this period, the Simpson sea transgressed and regressed, 

depositing this group; Late Devonian erosion removed any Upper Ordovician, 

Silurian, and Lower Devonian units that may have been deposited (Thorman 

and Hibpshman, 1979). 

During the Middle Devonian, the Misener Sandstone was deposited from 

reworked Simpson sands; however, the Misener rarely exceeds 6 m (20 ft) in 

thickness and is only present in the southwestern part of the county as well as a 

small patch northwest of Bartlesville (Thorman and Hibpshman, 1979).  The 

Late Devonian Woodford Shale, which is a black carbonaceous fissile rock, 
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overlies the Misener and is present throughout most of the county, but the 

thickness of Woodford rarely exceeds 15-20 m (50-75 ft) and is commonly 

absent over pre-Late Devonian topographic highs (Thorman and Hibpshman, 

1979). 

The Mississippi Lime, Lower Mississippian in age, overlies the Woodford 

Shale, although in places where the Woodford is absent, the lime overlies the 

Simpson and Arbuckle groups (Thorman and Hibpshman, 1979).  The lime is 

present throughout the county with thickness ranging from 30-120 m (100-400 

ft) and is composed of limestone, dolomite, and cherty limestone (Thorman and 

Hibpshman, 1979).  The unconformity between the Mississippian and the 

Pennsylvanian resulted in an erosional, irregular surface at the top of the 

Mississippian with local relief in excess of 30 m (100 ft; Thorman and 

Hibpshman, 1979). 

Following the orogenic events of Early and Middle Pennsylvanian, Middle 

and Late Pennsylvanian seas moved across the county interacting with major 

drainage systems, resulting in marine-delta deposition of sandstones and 

limestones (Thorman and Hibpshman, 1979).  The base of the Pennsylvanian is 

the Mississippian Chert, a conglomerate derived from the underlying 

Mississippian Lime and deposited in an irregular channel system (Thorman and 

Hibpshman, 1979).  Pennsylvanian units deposited on top of the chert include 

the Red Fork, Pink, Skinner, and Verdigris sandstones and the Oswego 

limestone.  
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Figure 8: Generalized stratigraphic column for Osage County.  “Osage A” is as 
a silicified limestone with high diagenetic susceptibility, and is where tripolite 
most commonly occurs.  “Osage B” contains interbedded tight, fractured 
limestone and chert and has low diagenetic susceptibility.  The St. Joe 
Limestone is the basal unit of the Mississippian in Osage County and contains 
no chert (Matson, 2013; Elebiju et al., 2011). 
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Figure 9 is Rogers’ (1996, 2001) model for the diagenesis and deposition 

of both Mississippian chert lithologies.  Rogers’ (2001) model for the formation 

of the Mississippian chert describes two contemporaneous processes in two 

different settings.  The first setting is along the shelf edge as illustrated in Figure 

9a, 9c, and 9e, while the second setting is a subaerially exposed area as 

illustrated in Figure 9b, 9d, and 9f.  Both settings involve dual-stage diagenesis 

(Rogers, 2001). 

In the first setting along the shelf edge, cherty limestone erodes from the 

fore-reef and/or the shelf and is redeposited downslope in a mud matrix, as 

shown in Figure 9a (Rogers 2001).  Stage one diagenesis begins with silica 

replacement of calcite, shown in Figure 9c.  Stage two diagenesis follows with 

the dissolution of remaining calcite, possibly by leaching from infiltrated 

meteoric water, seen in Figure 9e (Rogers, 2001).  Setting one is Rogers’ 

(2001) model for the deposition of the hard, tight chert. 

Rogers’ (2001) second setting is subaerially exposed paleohighs, 

illustrated in Figure 9b, where deposition occurs from in situ weathering, 

resulting in vug and karst development, collapse breccia deposits, and the 

development of porous chert.  Again, stage one diagenesis is the replacement 

of calcite with silica, shown in Figure 9d.  Stage two diagenesis follows with the 

infiltration of meteoric water dissolving any remaining calcite (Rogers, 2001).  

Setting two is Rogers’ (2001) model for the deposition of the porous, tripolitic 

chert.  
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Figure 9: Models showing the depositional and diagenetic scenarios for the two 
types of chert lithologies.  Deposition stage in setting one (a) involves fore-reef 
and/or shelf erosion of cherty limestone and redeposition of eroded material.  
Deposition stage in setting two (b) involves weathering-in-place on exposed 
paleohighs and development of porous chert.  Diagenesis stage one is the silica 
replacement of calcite (c, d).  Diagenesis stage two is the dissolution of any 
remaining calcite, possibly leaching by meteoric waters (e, f) (from Rogers, 
2001).  
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CHAPTER 3: 3D PRESTACK SEISMIC PROCESSING 

AVAILABLE DATA 

Spyglass Energy, LLC, a small independent oil and gas exploration and 

production company located in Tulsa, Oklahoma, has provided me with a 3D 

prestack seismic survey acquired in northwestern Osage County, Oklahoma, 

near the town of Foraker.  In this chapter, I present the most important results of 

my processing flows, with a detailed discussion in Appendix A and as a DVD to 

allow less experienced processors to mimic my workflow. 

Figure 1 shows the location of the survey within Osage County.  Table 1 

summarizes the acquisition parameters representing common values used for a 

Midcontinent U.S.A. 3D seismic survey.  The CMP bin spacing is 33.5 by 33.5 

m (110 by 110 ft), the receiver group spacing is 67 m (220 ft) and the receiver 

line spacing is 201 m (660 ft).  For each shot, there are ten live receiver lines, 

each with 52 active channels.  The shot spacing is 67 m (220 ft) and the shot 

line spacing is 100 m (330 ft).  The survey is mostly narrow azimuth, however; 

there are locations that come close to having wide azimuth acquisition.  As the 

target zone is relatively shallow, the record length is 2 seconds at a 2 ms 

sampling interval, or 500 samples per second.  The overall quality of the data is 

very good with recorded frequencies between 10 and 120 Hz.  The dominant 

frequency at the target depth of 880 m (2900 ft, 0.530 s) is 50 Hz with a velocity 

of approximately 3048 m/s (10,000 ft/s), resulting in a tuning thickness vertical 

resolution of about 15.2 m (50 ft). 

  



22 

Receiver spacing 67 m (220 ft) 

Receiver line space 201 m (660 ft) 

Active receiver lines per shot 10 Lines 

Live channels per receiver line 52 channels 

Shot spacing 67 m (220 ft) 

Shot line spacing 100 m (330 ft) 

Source type Vibroseis 

Sweep parameters* - Eight 10 second sweeps 

- 16-120 Hz 

- Increasing 3 dB/oct 

- 500 ms taper at start and 

end 

Record length 2 seconds (2000 ms) 

Sample interval 2 ms 

CMP bin size 33.5 x 33.5 m (110 x 110 ft) 

Maximum CMP fold 186 

Average CMP fold 60 

Tuning thickness 15.2 m (50 ft) 

Lateral resolution (Fresnel 

Zone) for unmigrated data 

80 m (280 ft) 

Table 1: Summary of acquisition parameters for 3D prestack seismic survey. 
(*Sweep parameters are unknown, but the values presented in the table are 
typical for the Midcontinent U.S.A., and appear to be close approximates 
according to the raw spectrum (Karr and Hefner, 2010)). 
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PROCESSING 

I begin with a 17 GB 3D prestack seismic survey that contains raw shot 

records, retaining the contractor’s computed refraction and elevation statics.  

The target zone is relatively shallow at approximately 530 ms with basement 

occurring at approximately 700 ms.  In order to improve vertical and horizontal 

resolution, my processing objective is to remove ground roll and coherent noise 

as much as possible and to reduce the acquisition footprint that contaminates 

the shallow section of the data.  Prestack time migration will enhance subtle 

structure.  Figure 10 shows the generalized processing workflow. 

The first step is to load the data and make sure that the header geometry 

is consistent with the kinematics of the first breaks, thereby forming a quality 

control.  Geometry QC is a critical step, and it is necessary to spend time and 

care to ensure that the data are properly loaded.  The geometry database is 

created and applied to the trace headers, which includes defining the midpoint 

binning grid and binning the midpoints. 

Figure 11a shows the source and receiver geometry for this survey.  For 

each source, there are 10 live receiver lines with 52 geophones per line.  The 

survey is a merge of two independently acquired patches: North and South.  

After defining the midpoint-binning grid and binning the midpoints, the CMP fold 

map shows a maximum fold of 186, although the fold is closer to 60 for the 

majority of the survey, shown in Figure 11b.  Figure 12 shows the offset 

distribution, with the maximum offset approaching 3,658 m (12,000 ft), while the 

most commonly occurring offset is about 914 m (3,000 ft).  
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Figure 10: Generalized processing workflow used in this thesis. 
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Figure 11: (a) Shot and receiver geometry for 3D prestack seismic survey.  
Black points represent shot locations and white points represent receiver 
locations.  A representative shot gather geometry is shown in red.  (b) CMP fold 
map showing a maximum fold of 186, although most of the survey has a fold 
between 60-80.  The survey was acquired in two patches, which can be 
observed on the fold map.  The low fold between the patches (black arrow) will 
result in lower signal to noise in this area.  The low-fold hole near the center of 
the survey (white arrow) is a town site.  The blue circle indicates the location of 
the CMP shown in Figure 16, while the yellow circle indicates the location of the 
shot gather shown in Figure 13.  
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Figure 12: Offset distribution of the 3D prestack seismic survey. 
 

Figure 13a shows a representative raw shot record indicated by the 

yellow circle in Figure 11a, sorted by source location number and channel 

number.  Other than the previously applied refraction and datum statics and 

applying geometry, the records are raw.  Groundroll is quite prevalent, 

especially at the near offsets.  Figure 13b shows the spectral content of the shot 

record shown in Figure 13a.  Frequencies below 10 Hz are below -60 dB.  The 

slope between 10 and 18 Hz is about 80 dB/Octave.  Frequencies between 15 

and 110 Hz are at -25 dB and above, accounting for most of the data’s spectral 

content.  After a peak around 23 Hz at -0.15 dB, the frequencies begin to drop 

off.  The frequencies between 45 and 110 Hz have a slope of -12 dB/Octave, 

and then the slope becomes -530 dB/Octave between 110 and 120 Hz.  Figure 
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14 shows the same shot record, but the secondary sort is by the absolute value 

of the offset.  Both the groundroll and air blast are noticeable, overwhelming 

actual signal at near offsets.  
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Figure 13: (a) Raw shot record after applying geometry, sorted by source 
station number and recording channel showing the ten live receiver lines in the 
patch.  The yellow symbol indicates the source location.  Groundroll (red 
arrows) dies off at further offsets where signal (green arrows) becomes more 
prevalent.  (b) Spectral content for the same shot.  Frequencies range between 
18-110 Hz.   
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Figure 14: The same raw shot record from Figure 12a.  Green arrows indicate 
signal and red arrows indicate groundroll and air blast.  
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Figure 15 shows a suite of records with various bandpass filters applied.  

Figure 15a shows the raw shot record with an Ormsby bandpass 0-0-10-20 Hz 

filter applied.  Groundroll and the air blast dominate this frequency band, 

although there is some signal present. Figure 15b shows the shot record 

bandpass filtered with corner frequencies of 10-20-30-40 Hz.  Groundroll is still 

very dominant in this frequency band.  Figure 15c shows the shot record 

bandpass filtered between 90, 100, 110, and 120 Hz.  This filter band contains 

some signal but also appears to contain some aliased noise.  Finally, Figure 

15d shows the shot record filtered between 10, 20, 90, and 120 Hz.  Although 

the groundroll leaks up into the mid 20 Hz frequencies, preserving the low 

frequencies as much as possible is important.  Setting the low cut corner at 10 

Hz and the low pass corner at 20 Hz allows for a more gradual ramp, filtering 

out some of the offending groundroll while still preserving some of the lower 

frequencies.  This is the filter design used for the rest of the processing flow, as 

well as for time-variant spectral whitening.  



31 

 
Figure 15: A series of bandpass filters applied to the same shot record.  (a) 
Bandpass filtered 0-0-10-20 Hz.  (b) Bandpass filtered 10-20-30-40 Hz.  (c) 
Bandpass filtered 90-100-110-120 Hz.  (d) Bandpass filtered 10-20-90-120 Hz.  
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After applying the geometry to the data, I begin testing for true amplitude 

recovery, using a parameter test of 2, 4, 6, 8, 10, and 12 dB/sec true amplitude 

recovery constant corrections, with the best correction to be 9 dB/s.  A series of 

time gates are picked and then used to apply time-variant scaling to better 

balance the data.  Trace statistics are calculated and used to perform trace 

edits.  The trace statistics used for editing include spikiness (maximum 

amplitude divided by average amplitude), average trace energy, and statistical 

frequency deviation. 

Before beginning velocity analysis, a “preliminary” deconvolved dataset 

is created.  It is preliminary because it only uses spiking deconvolution, 

whereas later use surface-consistent deconvolution is used after having phase 

matched the two patches of the survey to one another.  The spiking 

deconvolution uses a zero phase 120 ms operator with 0.1% white noise.  I also 

apply a top mute, air blast attenuation, AGC and a 10-20-90-120 Hz bandpass 

filter.  Figure 16 shows a representative CMP gather before and after spiking.  

The deconvolution and noise attenuation parameters have eliminated much of 

the groundroll and air blast and retained coherent reflector events visible down 

to almost 1100 ms at the far offsets.  Figure 17 shows the corresponding 

spectral content of the CMP gather before and after.  
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Figure 16: (a) A representative CMP gather after applying geometry and AGC.  
Groundroll and coherent noise is prevalent.  The location of the CMP gather is 
indicated by a blue circle in Figure 11.  (b) The same CMP after spiking 
deconvolution, top mute, air blast attenuation, AGC, and a 10-20-90-120 Hz 
bandpass filter.  Groundroll is less prevalent and reflection events are better 
resolved.  
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Figure 17: Spectrum of the CMP gather in Figure 16 (a) before and (b) after 
spiking deconvolution.  The frequencies in (a) peak at 20 Hz and begin to fall off 
rapidly after 50 Hz.  The spectrum in (b) is much flatter due to the spiking 
deconvolution operation.  
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An iterative process of velocity analysis and residual statics calculation 

begins by picking velocities for a single CMP.  The corresponding NMO 

correction is applied to the deconvolved gathers using this single point velocity 

analysis, followed by calculating and applying residual statics, and then 

stacking the NMO corrected gathers to create a brute stack.  After this first pass 

of residual statics, a new velocity analysis is performed picking on an 80x80 

inline-crossline grid, applying the corresponding NMO correction to the 

deconvolved gathers using the new velocity field, and calculating new residual 

statics and stacking.  This cycle of velocity analysis, NMO correction, residual 

statics calculation, and stacking continues using a 40x40 grid, and finally a 

20x20 grid.  Each time a new round of velocity analysis begins, the residual 

statics from the previous iteration are applied, and the previous velocity field 

serves as a guide function while picking on the finer grid.  Ideally, the residual 

statics should eventually converge to a 0 ms correction.  After the first pass, the 

residuals for most sources and receivers already fall between +/- 2.0 ms, which 

is the same as the data’s sample interval.  After the second pass, most 

residuals fall between +/- 1.0 ms.  Figure 18a-d shows a representative CMP 

gather with NMO correction after each velocity analysis pass.  As the velocity 

analysis becomes finer, events are better resolved.  Figure 19-22 show the 

stack after each velocity analysis iteration.  
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Figure 18: NMO-corrected CMP gather shown in Figure 16 using velocities 
computed a) on a single point, and on (b) an 80x80, (c) a 40x40, and (d) a 
20x20 grid.  The data in (d) were subjected to prestack structure-oriented 
filtering. 
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Figure 19: Line AA’ through the brute stack, computed using a single velocity 
analysis location and after the first pass of residual statics.  
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Figure 20: Line AA’ through the stack after 80x80 grid velocity analysis and two 
pass of residual statics..  Reflectors between 200-700 ms are better resolved.  
The basement structure begins to be resolved.  
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Figure 21: Line AA’ through the stack after 40x40 grid velocity analysis, three 
passes of residual statics, and phase matching patch 1 to patch 2.  Reflectors 
align better and the basement structure continues to be better resolved.  
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Figure 22: Line AA’ through the stack after prestack structure-oriented filtering, 
20x20 grid velocity analysis, phase matching, and four passes of residual 
statics.  Resolution of reflectors between 400 and 600 ms increases.  White 
arrows indicates an intra-basement reflector.  
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Once the second round of velocity analysis using the 80x80 grid is 

complete, a flow to phase match patch 1 to patch 2 is created.  The fold 

distribution is more even in patch 2 while patch 1 has several obstacles due to 

the town of Foraker and no-permit zones, giving rise to holes in the fold map.  

The phase rotation patch 1 needs to match patch 2 is -50.47°.  After applying 

the rotation, I restack using the 80x80 velocity field and compare it to the 80x80 

stack before phase matching.  The 80x80 stack shown in Figure 20 is before 

phase matching.  The stack divided into patch 1 and patch 2 is shown in Figure 

23 and the phase matched 80x80 stack in Figure 24.  The reflectors now align 

much better and the “tear” or “seam” between the two patches is much less 

noticeable. 

With the phase match filter derived, I return to the gathers that have 

geometry applied and trace edits and create a surface-consistent deconvolution 

flow.  In this flow, the phase rotation, a top mute, air blast attenuation, time-

variant spectral whitening, time-variant scaling, and a 10-20-90-120 Hz 

bandpass filter are all applied.  The surface-consistent deconvolution goes 

between the top mute and the air blast attenuation steps.  The surface-

consistent deconvolution applies spiking deconvolution using the sources, 

receivers, offset, and CMPs for spectral decomposition.  However, only the 

source and receiver components are applied.  The operator is 120 ms in length 

with 0.1% white noise.  The offsets are limited between 152 m (500.0 ft) and 

1067 m (3500.0 ft) in calculating the operator, using five Gauss-Siedel iterations 

as recommended by Cary and Lorentz (1991).  
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Figure 23: Stack after 80x80 grid velocity analysis divided into patch 1 (above) 
and patch 2 (below).  The red line indicates the “seam” in the middle of the 
survey that results from the low fold between the two patches. 
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Figure 24: Stack after 80x80 grid velocity analysis with patch 1 phase rotated -
50.47 degrees to match patch 2.  The phase rotation is applied to gathers prior 
to stacking.  
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The previous spiking deconvolution facilitated velocity analysis, residual 

statics, and phase matching, but is suboptimal to surface-consistent 

deconvolution.  I retain the velocity analysis and statics corrections but apply 

surface consistent deconvolution to the gathers as shown in Figure 10.  Figure 

25a shows a CMP gather after applying surface-consistent deconvolution and 

the noise attenuation processes (top mute, air blast attenuation, time-variant 

spectral whitening, time variant scaling, and bandpass filter).  There is a 

significant reduction in groundroll contamination, and events down to 1200 ms 

are better resolved across almost all offsets.  Figure 25b shows the spectral 

content of the CMP in Figure 25a.  The frequencies are now much flatter 

throughout and there has been a slight extension of the low frequencies before 

they roll off. 

Once completing the third round of velocity analysis using the 40x40 

grid, the surface-consistent deconvolved CMP gathers are written out to SEGY.  

While the gathers are cleaned up fairly well, application of a prestack structure-

oriented filter will further enhance signal and reduce noise and groundroll.  The 

structure-oriented filter works as follows: a stack of the NMO corrected input 

gathers is used to calculate the dip using a maximum correlation technique.  

This dip model is then used to guide the filter planes along modeled constant 

offset gathers.  The applied filter is a robust statistics filter with edge preserving 

properties.  After filtering the modeled data, the estimated noise model is 

adaptively subtracted from the original input gathers.  The filtered gathers are 

imported back into the processing software to continue with the final 20x20 
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velocity analysis and residual statics calculation.  The prestack structure-

oriented filter vastly improves the data’s signal-to-noise ratio (SNR).  Groundroll 

and coherent noise is almost negligible while the actual events, or signal, are 

very clear.  Figure 26a shows a representative CMP gather after applying the 

filter.  Figure 26b shows the spectral content of the data. 
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Figure 25: (a) CMP gather after applying surface-consistent deconvolution, air 
blast attenuation, time-variant spectral whitening, time-variant scaling, and a 
bandpass filter.  Suppression of noise brings out signal almost down to 1200 
ms.  (b) Spectrum of the CMP gather, which is now quite flat 
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Figure 26: (a) Surface-consistent deconvolved CMP gather after applying a 
prestack structure-oriented filter.  Noise contamination is almost indiscernible.  
(b) Spectrum of the CMP after applying a prestack structure-oriented filter. 
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Applying a prestack structure-oriented filter not only removes groundroll 

and coherent noise; it also improves the semblance calculations for velocity 

analysis.  This enhances velocity picking, increasing both the accuracy of the 

picks and the number of reflectors resolved.  Figure 27 shows a semblance 

panel from velocity analysis prior to applying the prestack structure-oriented 

filter, while Figure 28 shows a semblance panel from velocity analysis after 

applying the filter. 

After the 20x20 velocity analysis, the surface-consistent deconvolved 

gathers with the prestack structure-oriented filter applied are written out as the 

final gathers.  The final velocity field facilitates the application of a 1/distance 

spherical divergence true amplitude recovery, followed by applying a final time-

variant spectral whitening, time-variant scaling, and bandpass filter, using the 

frequencies 10, 20, 90, and 120 Hz for the corners of both the time-variant 

spectral whitening and bandpass filter.  Figure 29a shows a representative 

CMP from the final gathers, and the spectral content is shown in Figure 29b.  

The final velocity field is exported to SEGY, first interpolating it to a 1x1 grid so 

there is a pick at every CMP, and then smoothing the velocity field at a 3x3 

increment.  Resampling the velocity field to a 2.0 ms sample interval matches it 

to the seismic data.  Figure 30 shows a line from the final velocity field that for 

prestack time migration. 
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Figure 27: Velocity analysis semblance panel and CMP supergather prior to 
the application of a prestack structure-oriented filter.  I am able to resolve 
events between 400 and 700 ms fairly well, but noise overwhelms signal 
outside of this window. 
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Figure 28: Velocity analysis semblance panel and CMP supergather after 
applying a prestack structure-oriented filter to the data.  Semblance “bullseyes” 
are clearer and I am able to resolve reflectors from 150 to 700 ms very well.  
Additionally, basement structure is now more visible with the presence of 
groundroll drastically reduced. 
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Figure 29: (a) Final gathers for PSTM, and (b) Spectrum of final gathers. 
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Figure 30: Line AA’ through the final RMS velocity field, co-rendered with 
seismic amplitude.  The velocities are interpolated for every CMP from the 
20x20 grid, smoothed 3x3, and resampled to 2.0 ms to match the seismic data.  
This velocity field will be used for PSTM.  
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PRESTACK TIME MIGRATION 

Now that the bulk of the processing is complete, the data are ready for 

migration.  Given irregularities in shot and receiver lines (Figure 11) and the 

smooth lateral variation in velocity (Figure 30), a Kirchhoff prestack time 

migration (PSTM) algorithm is well suited.  PSTM allows for better imaging of 

subtle discontinuities in an otherwise mostly flat terrain and improves the 

seismic data’s lateral resolution.  Kirchhoff algorithms use diffraction imaging 

and summing to locate properly an event in the subsurface. 

This particular Kirchhoff PSTM algorithm has the ability to bin both 

offsets and azimuths.  For this migration, only a single azimuth bin and 60 offset 

bins are selected, setting the maximum offset at 3048 m (10,000 ft) which will 

result in incident angles of greater than 45° at my target depth of approximately 

910 m (3000 ft), illustrated in Figure 31.  The high angle offsets allow inversion 

for densities.  The migration aperture is 3048 m (10,000 ft).  By applying time-

variant scaling during processing, the data must be scaled by t-1 (t = time) 

because the migration code expects the amplitudes to decay by t-1.  Figure 32 

shows the same CMP gather shown in Figure 16 after migration. 

Migration moves the data laterally as well as vertically, and thus usually 

needs a slightly different velocity.  Therefore, using a reverse NMO algorithm 

with the migration velocities unflattens the gathers, followed by picking new 

velocities on a 20x20 grid using the migrated, un-flattened gathers.  Using the 

new velocities, an NMO correction is applied to the gathers with a 50% stretch 

mute to retain as many of the far offsets as possible.  Following NMO is a final 
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prestack structure-oriented filter and spectral whitening.  Figure 33 shows a 

final common reflection point (CRP) gather after applying NMO with the new 

velocity field and the final prestack structure-oriented filter and spectral 

whitening. 

 
Figure 31: Illustration showing that with a maximum offset of 10,000 ft for 
migration and a target depth of 3000 ft, I can recover greater than 45° incident 
angle, allowing me to invert for densities in addition to ZP and ZS. 
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Figure 32: CMP gather after Kirchhoff PSTM using 60 offset bins and 1 
azimuth bin, and an emergence angle of 60 degrees.  
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Figure 33: Migrated gathers after reverse NMO, picking new velocities, 
applying an NMO correction with a 50% stretch mute to retain as many far 
offsets as possible, and a final prestack structure-oriented filter and spectral 
whitening. 
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COMPARISON WITH VENDOR-PROCESSED DATA 

A significant advantage of reprocessing is access to the previous images 

and therefore insight into not only the geologic objective but also limitations of 

the previously used processing workflow (such as acquisition footprint).  Figure 

34a shows line AA’ from the vendor provided stack.  From the EBCDIC header, 

the vendor’s processing history includes the application of refraction and 

elevation statics, PSTM, time-variant scaling, a 14/112 Hz bandpass filter, and 

FX deconvolution.  The spectra of the vendor’s processed data is shown in 

Figure 34b.  After 70 Hz, the frequencies begin to fall off, decreasing by more 

than 5 dB by 100 Hz. 

For comparison, vertical line AA’ through the stack of the reprocessed 

data after PSTM, new velocities, NMO, prestack structure-oriented filtering and 

spectral whitening is shown in Figure 35a.  Note that the reflectors are not only 

more continuous but exhibit higher bandwidth as well.  Additionally, by avoiding 

FX deconvolution, the sub 700 ms basement structure resolves better and is 

more believable.  FX deconvolution has over-smoothed these reflectors 

resulting in the wormy appearance of the basement in the vendor’s stack 

section, and also reduces some of the higher frequency content.  Figure 35b, 

shows the spectrum of the final reprocessed stack section.  The spectrum is 

much flatter and retains the higher frequencies better than the vendor’s retains. 
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Figure 34: (a) Line AA’ through the previous vendor supplied migrated data 
volume.  The target zone between 500 and 600 ms does not show as many 
reflectors or as high of frequency.  The sub 700 ms basement is wormy in 
appearance due to FX deconvolution, which masks the basement structure.  (b) 
the spectrum of the vendor supplied migrated data volume.  The frequencies 
begin to roll off around 70. 
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Figure 35: (a) Final stack section after PSTM, residual velocity analysis, NMO, 
prestack structure-oriented filtering and spectral whitening.  More reflectors are 
resolved and the basement structure is more apparent.  (b) Spectrum of the 
final stack section after PSTM and residual velocity analysis.  The spectrum is 
flatter and better preserves the high frequencies. 
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Figure 36 shows a time slice of coherence through the vendor’s data at 

the approximate Arbuckle level at t = 560 ms, which is compared to a time slice 

of coherence through the final reprocessed data in Figure 37.  Coherence is 

useful in comparing the resolution of the two volumes.  Counter-intuitively, 

better resolution will result in more incoherence because the subtle features of 

the seismic are better resolved.  The subtleties are better imaged in the 

reprocessed volume, especially in the northeast corner.  However, the linear 

east-west trend in the center of the reprocessed volume is likely the effect of the 

seam between the two patches. 
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Figure 36: Coherence time slice (t=560 ms) through the vendor’s processed 
data at the approximate Arbuckle level.  
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Figure 37: Coherence time slice (t=560 ms) through my final stack section at 
the approximate Arbuckle level.  
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CHAPTER 4: ATTRIBUTE CHARACTERIZATION OF A 

MISSISSIPPI LIME SURVEY 

THEORY 

The P-wave velocity, VP, of sound in a linearly elastic media is: 

𝑉! =
!!!!
!

,       (4.1) 

where λ is the incompressibility, µ is the shear modulus, and ρ is the density of 

the rock.  Together, λ and µ are the Lamé parameters in linear elasticity.  The 

first parameter, λ, is often called the incompressibility and is sensitive to pore 

fluids.  The second parameter, µ, is often called the rigidity of the rock and is 

unaffected by any present fluids as shear stress is not supported by fluids or 

gases.  Similarly, the S-wave velocity, VS, is: 

𝑉! =
!
!
,        (4.2) 

indicating that VS is not sensitive to pore fluids but instead to the rock matrix. 

The P-Impedance, ZP, is: 

𝑍! = 𝜌𝑉!,        (4.3) 

where ρ is the density of the rock and VP is the P-wave velocity.  Impedance 

contrasts between layers in the Earth allow us to record seismic reflections and 

is the basis for defining reflection coefficients.  The S-Impedance, ZS, is: 

𝑍! = 𝜌𝑉!,        (4.4) 
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where again ρ is the density of the rock and VS is the S-wave velocity.  Both ZP 

and ZS are sensitive to changes in lithology; however, ZS is not sensitive to 

changes in pore fluid. 

Goodway et al. (1997) proposed that by rearranging the equations for VP 

and VS in terms of λ and µ and scaling by ρ, the orthogonal Lamé parameters 

can be extracted from logs or seismic data via the impedance equations.  

Rearranging equation 4.1 to solve for λ and equation 4.2 to solve for µ gives: 

𝜆 = 𝑉!!𝜌 − 2𝜇,       (4.5) 

𝜇 = 𝑉!!𝜌,        (4.6) 

while equation 4.5 is reduced to: 

𝜆 = 𝑉!!𝜌 − 2𝑉!!𝜌,      (4.7) 

expressing λ and µ in terms of P- and S-wave velocity and density.  Multiplying 

equations 4.6 and 4.7 by ρ allows λ and µ to be expressed in terms of ZP and 

ZS, which are both easily extracted from well logs and prestack seismic data.  

This gives the attributes λρ and µρ, defined as: 

𝜆𝜌 = 𝑍!! − 2𝑍!!,       (4.8) 

𝜇𝜌 = 𝑍!!,        (4.9) 

and allow us to better extract rock properties from 3D prestack seismic data 

using elastic parameters directly linked to the rock’s bulk and shear moduli 

(Goodway et al., 1997).  Additionally, Poisson’s ratio (σ), the ratio of transverse 

to axial strain when a material is compressed, can be derived using ZP and ZS: 
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𝜎 = !
!

(!!!!
)!!!

(!!!!
)!!!

,                (4.10) 

and by using this relationship, deriving a Poisson’s ratio volume using the P- 

and S-Impedance volumes is straightforward. 

Generating several surface seismic attributes to aids interpretation.  

Coherence is an edge-detection attribute and measures the similarity between 

neighboring waveforms.  When neighboring traces are very similar, the data 

exhibit high coherence, which is an indication that there is a low amount of 

lateral and vertical variations in the seismic data.  If the neighboring traces are 

not similar, the data exhibit low coherence, and in the absence of strong 

acquisition footprint contamination can be useful for interpreting structural 

discontinuities.  In particular, I use the energy-ratio similarity for computing 

coherence.  Energy-ratio similarity is computed along structure and uses the 

analytic trace (the original data and its Hilbert transform or quadrature) in the 

computation (Chopra and Marfurt, 2007).  Numerically, it is the ratio of the 

energy of the Karhunen-Loeve filtered data over the total (unfiltered) energy of 

the input data within an analysis window (Chopra and Marfurt, 2007).  In 

carbonate terrains, circular features that exhibit low coherence commonly 

correspond to karst collapse or karst tower features.  More linear features 

detected by coherence attributes commonly correspond with faults.  Channel 

edges often give rise to meandering features. 
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Curvature is a mathematical measure of a quadratic surface’s deviation 

from a plane and can be useful for interpreting structure in 3D seismic data.  In 

2D curvature is computed by fitting a circle to a curved region such that: 

𝜅 = !
!
,                 (4.11) 

where R is the radius of the circle which fits the curved surface.  In 3D, any 

quadratic surface can be described by two orthogonal “principal” curvatures.  k1, 

called the most-positive principal curvature is the larger of the two in signed 

value and describes ridge-like structures..  k2, the most-negative principal 

curvature, describes valley-like structures.  Most-positive and most-negative 

implies there is no other apparent curvature that is more positive than k1 or 

more negative than k2.  While both k1 and k2 can have positive values (for a 

dome) or negative values (for a bowl), k1 is always greater than or equal to k2.  

Of particular interest to my work are experiments conducted by Staples (2011) 

and White (2013) which show a direct relationship between curvature and 

fractures, indicating that curvature extracted from 3D seismic data can be used 

as a proxy for fracture detection. 

PETROPHYSICAL PROPERTIES 

Snyder et al. (2013) present a characteristic type log for the tripolitic 

chert versus the tight limestone and tight chert, which is shown in Figure 38.  

The type log comes from a well that penetrates the Highway 60 East Hardy 

tripolitic chert trend in western Osage County.  Compared to the tight limestone 

and tight chert that accounts for most of the Mississippian section, tripolitic chert 

shows low density, low resistivity, and low gamma ray.  
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Figure 38: Type log showing the response of tripolitic chert and tight limestone 
and tight chert.  The left set of logs is gamma ray and induction (resistivity), and 
the right set of logs is gamma ray and neutron density. 
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Matson (2013) defines three unique intervals in the Mississippian section 

of Osage County near the study area.  “Osage A” is encountered at the top of 

the Mississippian, lying unconformably beneath the Pennsylvanian Cherokee 

Shale, and is characterized as siliceous limestone with high susceptibility for 

diagenetic alteration to tripolitic chert.  “Osage B” occurs both with and below 

“Osage A” and contains interbedded tight, highly fractured limestone and tight 

nonporous chert, having low potential of diagenetic alteration.  The St. Joe 

Limestone (Kinderhookian) lies below “Osage B” and consists of limestone, 

showing some dolomitization, and is a chert free interval. 

Figure 39 shows the log response at “Well B” through the Mississippian, 

which is used for prestack inversion.  The top section, colored in blue, is 

characteristic of “Osage A”.  The middle section, colored in brown, is 

characteristic of “Osage B”.  The lower section, colored in green, is 

characteristic of the St. Joe Limestone.  The caliper track shows significant 

washout issues at the top of the Mississippian, as well as several more 

throughout the section.  Therefore, the logs required some editing, which 

included outlier cleaning and despiking, linear interpolation and splining if 

required, and the application of a Gaussian smoother.  Figure 40 shows the log 

editing workflow. 
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Figure 39: Selected logs at “Well B” before (black) and after (red) log editing.  
The dual calipers in track 1 (left) show significant borehole washout problems, 
indicated by arrows.  The Mississippian starts at approximately 888.5 m (2915 
ft) and extends to approximately 990.6 m (3250 ft), for a thickness of 
approximately 102.1 m (335 ft).  “Osage A” is colored in blue, “Osage B” in 
brown, and the St. Joe Limestone in green. 
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Figure 40: Workflow used to edit logs. 
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Total porosity (PHIT), which includes secondary porosity such as 

fractures, and the density of the apparent matrix (RHOMAA) are calculated 

using bulk density (RHOB) and enhanced thermal neutron porosity (NPOR).  P- 

and S-Impedance (ZP and ZS, respectively), lambda-rho and mu-rho (λρ and µρ, 

respectively), and VP/VS are calculated using the P- and S-wave sonic logs and 

bulk density log.  The volumetric photoelectric factor of the apparent matrix 

(UMAA) is derived using RHOMAA and the photoelectric factor (PEF) log, 

which is sensitive to changes in mineralogy.  Figure 41 shows log responses at 

“Well B” after editing and deriving the previously mentioned properties. 

RHOMAA values for “Osage A” are higher than bulk density (RHOB) 

values for two reasons: first, RHOMAA measures only the density of the matrix 

and discounts any porosity or fluid effect, and second, the matrix is highly 

silicified and exhibits densities close to quartz.  RHOMAA values for “Osage B” 

and the St. Joe do not vary as much for two reasons: first, porosity, both 

primary and secondary, in these two intervals is much less than observed in 

“Osage A”, so the porosity and fluid effect is not as pronounced on bulk density 

(RHOB) measurements, and second, because these intervals are much less 

silicified, the rock matrix is much less altered.  Zhao (2011) observes similar 

results comparing bulk density to rock matrix density from core plug 

measurements made on core from the a well which is a township north and a 

range east of “Well B” in Osage County. 
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Figure 41: Log response at “Well B” after edits and calculating PHIT, 
RHOMAA, VP/VS, ZP, ZS, λρ, µρ, and UMAA.  Density is the best discriminator 
for tripolitic chert/”Osage A”-type silicified limestone.  “Osage A” is colored in 
blue, “Osage B” in brown, and the St. Joe Limestone in green. 
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Figure 42 shows a crossplot of RHOB versus NPOR through the 

Mississippian section.  The St. Joe Limestone (in green) plots mostly along the 

limestone line.  “Osage B” (in brown), which consists of interbedded limestone 

and chert, plots between the limestone and sandstone lines.  “Osage A” (in 

blue), which is expected to plot near the sandstone line due to its highly 

siliceous content, plots between the limestone and dolomite lines.  However, 

“Osage A” also exhibits the highest porosities and lowest densities of the three 

intervals in the Mississippian. 

Figure 43 shows a crossplot of RHOMAA versus UMAA, both of which 

contain information about the apparent rock matrix.  The St. Joe (in green) plots 

near the calcite corner, as expected.  “Osage B” (in brown) plots between the 

quartz and calcite corners along the bottom edge, also as expected.  “Osage A” 

(in blue) now plots well into the quartz region, which confirms that the rock 

matrix of this section is very silica rich.  Therefore, in the previous figure, 

“Osage A” is plotting erroneously most likely due to borehole washout 

problems, which affect RHOB measurements. 

Figure 44 shows a crossplot of ZP versus PHIT through the 

Mississippian, while Figure 45 shows a crossplot of ZS versus PHIT.  “Osage A” 

clearly separates from “Osage B” and the St. Joe Limestone in both plots.  

“Osage A”, which contains tripolitic chert, shows the lowest impedance and 

highest porosities, confirming the hypothesis that as porosity increases, 

impedance decreases. 
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Figure 42: Crossplot of bulk density (RHOB) versus enhanced thermal neutron 
porosity (NPOR) through the Mississippian at “Well B”.  The St. Joe Limestone 
(green) plots mostly on the limestone line, while “Osage B” (brown) plots 
between the limestone and sandstone line, due to the presence of interbedded 
nonporous chert.  “Osage A” (blue) plots between the limestone and dolomite 
line, which is unexpected; however “Osage A” also exhibits the highest 
porosities and lowest densities.  
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Figure 43: Crossplot of RHOMAA versus UMAA through the Mississippian.  
Both RHOMAA and UMAA measure only the apparent matrix, discarding any 
fluid or porosity effects.  The St. Joe Limestone (green) plots near the calcite 
corner, and “Osage B” (brown) plots between the quartz and calcite corners, 
both as expected.  “Osage A” now plots well into the quartz region, indicating a 
highly silicified matrix.  Borehole washout problems are likely the cause of 
“Osage A” erroneously plotting in the previous figure.  
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Figure 44: Crossplot of ZP versus PHIT through the Mississippian.  “Osage A” 
(blue) is clearly separated from “Osage B” (brown) and the St. Joe Limestone 
(green), and exhibits the lowest impedances and highest porosities. 
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Figure 45: Crossplot of ZS versus PHIT through the Mississippian.  “Osage A” 
(blue) is clearly separated from “Osage B” (brown) and the St. Joe Limestone 
(green), and exhibits the lowest impedances and highest porosities. 
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Figure 46 shows the logs for total porosity (PHIT), bulk density (RHOB), 

density of the apparent matrix (RHOMAA), and intrinsic permeability (KINT) 

through the Mississippian, colored by interval, as before.  Figure 47a shows a 

histogram of intrinsic permeability through “Osage A”, Figure 47b shows a 

histogram of intrinsic permeability through “Osage B”, and Figure 47c shows a 

histogram of intrinsic permeability through the St. Joe Limestone.  These results 

show an important feature of the Mississippi Lime play.  Although typical 

tripolitic chert of “Osage A” exhibits high porosities ranging from 20-50% (4-24% 

in “Well B”), permeability tends to be low (0.01-13.3 mD in “Well B”), which is 

due to the unique nature of porosity in carbonates.  Porosity in the tripolitic chert 

consists mostly of moldic, vuggy and micro-porosity, which tend not to be well 

connected, and hence the importance of the natural fracture network in the 

interbedded tight limestone and nonporous chert (Rogers, 2001; Zhao, 2011; 

Dowdell et al., 2012; White et al., 2012).  Permeability observed in “Osage B” is 

likely due to fractures, as the interbedded limestone and chert of this interval 

are mainly nonporous.  “Reservoir quality” permeability typically needs to be 

greater than 100 mD; however, the Mississippi Lime is an unconventional 

resource play and requires on average 95 drops of water to produce 5 drops of 

oil. 
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Figure 46: Total porosity (PHIT), bulk density (RHOB), density of the apparent 
matrix (RHOMAA), and intrinsic permeability (KINT) for the Mississippian in 
“Well B”.  “Osage A” is colored in blue, “Osage B” in brown, and the St. Joe 
Limestone in green.  While “Osage A” exhibits high porosity, permeability is 
relatively low.  Porosity in tripolitic chert is mostly moldic, vuggy, and 
microporosity in the matrix, all of which tend not to be well connected (Rogers, 
2001; Zhao 2011).  
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Figure 47: Histogram of intrinsic permeability for (a) “Osage A”, (b) “Osage B”, 
and (c) the St. Joe Limestone in “Well B”.  “Osage A” exhibits the highest 
permeability of 13.34 mD.  “Osage B” exhibits a maximum permeability of 2.15 
mD, possibly due to fracture porosity.  The St. Joe Limestone exhibits very little 
permeability.  
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INVERSION 

Before performing simultaneous prestack seismic inversion, “Well B” 

needs to be tied to the prestack time migrated seismic data.  Figure 48 shows 

the seismic-well tie.  The left tracks show the P-wave sonic log, density log, and 

enhanced thermal neutron porosity log.  The synthetic trace calculated from ZP 

is shown in blue while the extracted trace from the seismic is shown in red.  The 

seismic data is shown in the furthest right trace, showing only offsets from 100 

to 2000 ft, which were used in extracting a trace to tie to the zero-offset 

synthetic.  The correlation between the synthetic and seismic is 80% in the 

window between 450 and 550 ms. 

The prestack time migrated data are stacked and loaded into an 

interpretation package to pick the top Oswego, Mississippi, and Arbuckle 

horizons, using well tops as guide.  Figure 49 shows a vertical section adjacent 

to the well location and the three picked horizons.  A strong reflection at 700 ms 

is the top of the granitic basement.  Figure 50, Figure 51, and Figure 52 show 

the two-way time (TWT) structure maps created from the picked Oswego, 

Mississippi, and Arbuckle horizons, respectively. 
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Figure 48: Seismic-well tie showing the synthetic generated from the P-wave 
sonic log and bulk density log using a statistical extracted wavelet.  The 
correlation coefficient between 450 and 550 ms is 80%. 
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Figure 49: Vertical slice BB’ through the seismic data near the well tie.  The 
Oswego, Mississippian, and Arbuckle top horizons are picked using well tops.  
There is an apparent vertical fault in the middle of the line; however, this is 
more likely an artifact of the “seam” between the two patches.  
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Figure 50: Seismic amplitude inline-crossline chair back with the Oswego TWT 
structure map from the picked Oswego horizon.  A black line across the 
Oswego surface indicates the location of vertical slice.  
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Figure 51: Seismic amplitude inline-crossline chair back with the Mississippian 
TWT structure map from the picked Mississippian horizon. 
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Figure 52: Seismic amplitude inline-crossline chair back with the Arbuckle TWT 
structure map from the picked Arbuckle horizon. 
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Next, the prestack time-migrated data are converted to angle gathers 

ranging from 0 to 45°, shown in Figure 53, and then low-frequency models for 

inverting ZP, ZS, and density from the seismic data and well logs are 

constructed.  While the picked horizons can be used in creating the low-

frequency models, in this instance they are not, as using the horizons in the 

model can bias the final inversion results.  Figure 54-56 show the low frequency 

models for ZP, ZS, and density inversion, respectively.  Simultaneous prestack 

inversion uses the low-frequency models, generating volumes for ZP, ZS, and 

density.  Once the inversion is complete, λρ and µρ volumes are transformed 

from the ZP and ZS volumes using equations 4.8 and 4.9. 
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Figure 53: Seven angle gathers from 0-45 degrees created from the input 
prestack time migrated seismic data.  The red P-wave log denotes the well 
location, and the picked horizons are shown in blue. 
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Figure 54: vertical slice BB’ through the low frequency model used for ZP 
inversion generated from horizon picks and logs.  
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Figure 55: vertical slice BB’ through the low frequency model used for ZS 
inversion generated from horizon picks and logs.  
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Figure 56: Vertical slice BB’ through the low frequency model built for density 
inversion using the angle gathers and the density log.  
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INTERPRETATION 

Figure 57-61 shows vertical line BB’ through the inverted ZP, ZS, density, 

λρ, and µρ estimates with seismic amplitude displayed as wiggle traces with 

variable area.  Warm colors indicate low values while cool colors indicate high 

values.  The crossplots in Figure 44 and 45 show that tripolite should occur as 

low values for each inversion volume, occurring near the top of the 

Mississippian.  White arrows indicate pockets of low ZP along the Mississippian.  

There is an abrupt change in ZP at the transition from siliceous limestone, which 

has high potential for diagenetic alteration to tripolite, to the interbedded chert 

and limestone, which has a significantly lower potential for diagenetic alteration 

to tripolite, and finally into the St. Joe limestone which contains no chert at all.  

Each of these attributes shows similar patterns.  As observed on well logs, 

density is the best discriminator of tripolitic chert (“Osage A”), from interbedded 

tight limestone and chert (“Osage B”), and tight limestone (St. Joe).  The scaled 

λρ and µρ volumes enhance the tripolite anomalies, but also indicate low 

anomalies at the top of the Arbuckle.  However, the well logs end right at the 

top of the Arbuckle, so the estimates for the Arbuckle and below are not 

calibrated to log control.  
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Figure 57: Vertical slice BB’ through seismic amplitude corendered with ZP.  
White arrows indicate potential pockets of tripolite within the Mississippian.  
Warm colors correspond with low ZP. 
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Figure 58: Vertical slice BB’ through seismic amplitude corendered with ZS.  
White arrows indicate potential pockets of tripolite within the Mississippian.  
Warm colors correspond with low ZS. 
  



95 

 
Figure 59: Vertical slice BB’ through seismic amplitude corendered with 
density.  White arrows point out low values of density, which is characteristic of 
tripolite.  Warm colors correspond with low density.  As observed on well logs, 
density is the best discriminator for tripolitic chert and “Osage A”-type siliceous 
limestone.  
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Figure 60: Vertical slice BB’ through seismic amplitude corendered with λρ.  
Warm colors correspond with low λρ.  Low values of λρ indicate potential 
pockets of tripolite, denoted by white arrows. 
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Figure 61: Vertical slice BB’ through seismic amplitude corendered with µρ.  
Warm colors correspond with µρ.  Low µρ indicates potential pockets of tripolite, 
denoted by white arrows. 
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Figure 62-66 show the inversion attributes extracted along the top of the 

Mississippian surface with a vertical seismic amplitude inline and crossline 

forming a chair back.  Again, warm colors indicate low values while cool colors 

indicate high values.  As tripolite is a diagenetic product, it is laterally 

discontinuous, resulting in a high amount of lateral variability.  Additionally, the 

tripolite is not only confined to the top of the Mississippian, but is found 

throughout the silicified limestone of “Osage A”, which makes up the top of the 

Mississippian interval in Osage County (Matson, 2013).  Because of this lateral 

and vertical variability, seismically mapping tripolite is challenging, yet with the 

aid of the inversion attributes, mapping the tripolite is possible. 
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Figure 62: ZP extracted on the top of the Mississippian horizon.  Low ZP 
corresponds with warm colors. 
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Figure 63: ZS extracted on the top of the Mississippian horizon.  Low values of 
ZS correspond to warm colors.  Because ZS is not sensitive to pore fluid, it is a 
good lithology discriminator. 
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Figure 64: Density extracted on the top of the Mississippian horizon.  Low 
density corresponds with warm colors.  Pockets of lower density may indicate 
tripolite.  
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Figure 65: λρ extracted on the top of the Mississippian horizon.  Tripolite is 
indicated by low values of λρ, shown in warm colors.  
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Figure 66: µρ extracted on top of the Mississippian horizon.  Tripolite is 
indicated by low values of µρ, shown in warm colors.  
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Figure 67 shows extracted geobodies after crossplotting the ZP and ZS 

inversion attribute volumes between the top of the Mississippian and Arbuckle, 

representing the entire Mississippian section.  Using log crossplots as a guide, 

polygons can be picked that correspond with “Osage A” (yellow), “Osage B” 

(orange), and the St. Joe Limestone (red), and then 3D geobodies are 

extracted.  The “Osage A” (yellow) geobody is laterally discontinuous and 

occurs almost entirely at the top of the Mississippian and represents tripolitic 

chert.  The “Osage B” (orange) geobody is much more continuous and occurs 

mostly in the top half of the Mississippian.  The St. Joe Limestone (red) 

geobody is largely continuous and occurs almost entirely at the bottom of the 

Mississippian. Figure 68 shows the geobodies extracted by crossplotting the VP 

and density inversion attribute volumes and exhibits similar patterns. 

Using the linear regression from the ZP and PHIT crossplot in Figure 44, 

a total porosity attribute volume is created between the top of the Mississippian 

and Arbuckle.  Figure 69 shows the geobodies extracted by crossplotting the 

total porosity and density attribute volumes.  The yellow polygon and extracted 

geobody correspond with zones of high porosity and low density, both 

characteristic of tripolitic chert in “Osage A”.  The orange polygon and extracted 

geobody correspond with zones of low porosity and intermediate to high 

density, which is characteristic of the interbedded fractured limestone and chert 

of “Osage B”.  The red polygon and extracted geobody correspond with the very 

low porosity and high density St. Joe Limestone at the bottom of the 

Mississippian.  
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Figure 67: Geobodies extracted by crossplotting ZP and ZS attribute volumes 
between the top of the Mississippian and Arbuckle, using log crossplots as a 
guide for picking polygons.  The “Osage A” (yellow) geobody corresponds with 
accumulations of tripolitic chert at the top of the Mississippian.  The “Osage B” 
(orange) geobody corresponds with interbedded fractured tight limestone and 
chert, while the St. Joe Limestone (red) geobody corresponds with the chert-
free limestone at the bottom of the Mississippian.  
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Figure 68: Geobodies extracted by crossplotting VP and density inversion 
attribute volumes between the top of the Mississippian and Arbuckle, using log 
crossplotting as a guide for picking polygons.  The “Osage A” (yellow) geobody 
corresponds with accumulations of tripolitic chert at the top of the Mississippian.  
The “Osage B” (orange) geobody corresponds with interbedded fractured tight 
limestone and chert, while the St. Joe Limestone (red) geobody corresponds 
with the chert-free limestone at the bottom of the Mississippian.  
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Figure 69: After creating a total porosity attribute volume using the linear 
regression from log crossplotting ZP and total porosity, the total porosity 
attribute volume is crossplotted with the density attribute volume, and then 
geobodies are extracted.  Accumulations of tripolitic chert are denoted by the 
yellow geobodies which correspond with zones of both low density and high 
porosity.  
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Figure 70 shows coherence extracted along the top of the Mississippian.  

Circular depressions along the top of the Mississippian are most likely karsts 

and may be filled with collapse breccias, which are an important part of Rogers’ 

(2001) model for chert formation.  Figure 71 shows coherence corendered with 

k1 most-positive principal curvature, and Figure 72 shows coherence 

corendered with k2 most-negative principal curvature.  There appears to be 

several linear trends of karst development that may be associated with 

basement faulting as suggested by Elebiju et al. (2011). 

Part of Rogers’ (2001) model for tripolite deposition includes a detrital 

tripolitic chert facies, which should express as chaotic and lowly coherent on 

seismic.  The lowly coherent zones seen in Figure 70-72 may correspond to 

detrital deposits of tripolite and collapse breccias, perhaps moved along fault 

zones detected by curvature and coherence.  Zones that are highly coherent 

and correspond with paleohills observed on the TWT structure map of the 

Mississippian in Figure 51 are also likely accumulations of tripolitic chert.  

These zones are highlighted by the geobodies extracted in Figure 67-69 and 

the patterns observed in Figure 62-66.  Conversely, tight limestone and chert 

seem to correspond with highly coherent areas which also reside in structural 

lows observed on the TWT structure map of the Mississippian in Figure 51. 
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Figure 70: Coherence extracted along the Mississippian horizon.  Circular 
feature along the surface are likely karst features, potentially filled with collapse 
breccias.  
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Figure 71: Coherence corendered with k1 most-positive principal curvature.  
Curvature anomalies coinciding with coherence anomalies bolster my 
interpretation of karst features, and there appears to be several linear trends 
that may be associated with basement faulting.  
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Figure 72: Coherence corendered with k2 most-negative principal curvature 
along the top of the Mississippian.  Curvature anomalies coinciding with circular 
coherence anomalies are likely karst features. 
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As previously mentioned, experiments by Staples (2011) and White 

(2013) suggest a relationship between fractures and curvature.  Figure 73 

shows an experiment in which a clay cake underwent plate bending, resulting in 

fracture formation along the hinge of the fold (Staples, 2011).  The surface of 

the deformed clay cake was laser scanned and then its curvature was 

calculated, showing a relationship between fractures, strain, and curvature 

(Staples, 2011). 

A 60 m section of a horizontal borehole image log from “Well B” is shown 

in Figure 74, both uninterpreted, above, and with interpreted natural fractures, 

below (White et al., 2012).  Fracture density is then calculated using the 

interpreted natural fractures along the horizontal borehole image log (White et 

al., 2012).  Expanding upon the relationship between curvature and fractures 

established by Staples (2011), White et al. (2012) show seismic amplitude 

corendered with curvature along a portion of vertical line BB’ with fracture 

density along the horizontal borehole at “Well B”, shown in Figure 75.  White et 

al. (2012) observe a correlation between high fracture density, calculated from 

interpreted horizontal borehole image logs, and 3D structural curvature. 
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Figure 73: Plate bending experiment using a clay cake showing (a) fractures 
forming along the hinge of the fold, and (b) curvature anomalies corresponding 
with the zone of strain which resulted in fracture formation (Staples, 2011). 
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Figure 74: A 60 m section of a horizontal borehole image log from “Well B”, 
both uninterpreted, above, and with interpreted natural fractures, below (White 
et al., 2012). 
 

 

 
Figure 75: A portion of vertical line BB’ showing seismic amplitude corendered 
with structural curvature, and the horizontal borehole at “Well B” with calculated 
fracture density from the interpreted natural fractures.  A correlation between 
curvature and fracture density is observed (White et al., 2012). 
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Figure 76 shows ZP extracted along the top of the Mississippian 

corendered with k1 most positive principal curvature in grayscale. Figure 77 

shows ZP extracted along the top of the Mississippian corendered with k2 most 

negative principal curvature in grayscale.  Tripolitic chert “sweet spots” are 

defined as a convergence between low impedance values, which indicate 

zones of low density and high porosity, and intense curvature anomalies, which 

may indicate areas of high fracture density critical to producing from the 

tripolite.  While k1 and k2 are sensitive to different features, both serve as a 

proxy to strain, and therefore both can be used as a proxy to zones of intense 

fracturing. 
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Figure 76: ZP along the top of the Mississippian with k1 most positive principal 
curvature corendered in grayscale.  Tripolitic chert “sweet spots” are the 
convergence of curvature anomalies, indicative of strain and a proxy for 
fractures, and low values of impedance, indicative of a rock exhibiting high 
porosity and low density, which are both characteristics of tripolitic chert.  
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Figure 77: ZP along the top of the Mississippian with k2 most negative principal 
curvature corendered in grayscale.  Tripolitic chert “sweet spots” are the 
convergence of curvature anomalies, indicative of strain and a proxy for 
fractures, and low values of impedance, indicative of a rock exhibiting high 
porosity and low density, which are both characteristics of tripolitic chert.  
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CHAPTER 5: CONCLUSIONS 

Tripolitic chert is a complex reservoir rock, and its discontinuous lateral 

distribution makes it challenging to map.  Characterized by low density and high 

porosity, it is very similar to unconsolidated sandstone.  The fact that it 

coincides with nonporous chert and tight, highly fractured siliceous limestone 

adds to the reservoir complexity.  It is a weathering, diagenetic product but does 

not have to occur at the top of the Mississippian.  For these reasons, it is 

extremely beneficial to use seismic attributes calibrated to well control when 

mapping tripolitic chert. 

I have shown that careful reprocessing of 3D prestack seismic data 

provides high quality data suitable for long-offset prestack inversion.  By using 

surface consistent deconvolution, time-variant spectral whitening and scaling, 

structure-oriented filtering, and paying careful attention to velocity analysis and 

residual statics, I am able to resolve more reflectors with higher frequency.  

Realizing that operations such as FX deconvolution applied by the vendor can 

harm the data resolution, I have stayed away from such algorithms.  The 

commercially-processed sub-700 ms basement appears very wormy.  Careful 

reprocessing results in sub-basement structures that I interpret to be either 

layered volcanics or intrusives.  Kirchhoff prestack time migration followed by 

velocity analysis, NMO, prestack structure-oriented filtering, and spectral 

whitening result in a properly imaged stack section and clean gathers with good 

offsets which can be used for prestack inversion. 
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Prestack inversion attributes applied to the long offset data provides an 

estimate of not only ZP and ZS, but also density, which is the single best 

discriminator of tripolite.  Log crossplots provide an improved estimation and 

guide for crossplotting seismic inversion attribute volumes.  The siliceous 

limestone, interbedded tight, fractured limestone and chert, and the tight St. Joe 

Limestone are also easily mapped.  Geometric attributes such as coherence 

and curvature not only show faults and karsts, but are correlated to fractures 

seen in the horizontal image logs (White et al., 2012).  Thus, an ideal target 

would be to drill horizontally in the thin bedded lime and chert perpendicular to 

folds (“fractures”) that fall below the tripolite seen on the impedance inversion. 
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APPENDIX A: 3D PRESTACK TIME PROCESSING 

A large portion of my thesis work involved reprocessing a 3D land 

seismic survey.  My dataset is a prestack time survey from the Midcontinent 

U.S.A. consisting of raw gathers with refraction and elevation statics applied.  

The purpose of this appendix is to document in detail how I reprocessed the 

data in hopes that it can be of some use to those who come after me.  For my 

thesis, I used Landmark’s ProMAX 3D software which has generously been 

provided to the University of Oklahoma for educational work.  Any 3D seismic 

processing package can be used, however.  I also use AASPI’s prestack 

utilities for migration and other data conditioning steps.  In addition to this 

appendix, I refer the reader to an accompanying slideshow that details each 

flow with parameterization as well as displays, which I include with this thesis as 

a DVD.  If I do not explicitly mention changing a parameter throughout this 

appendix, it is then implied that I use the default setting. 

The first step is to import the SEGY seismic data into ProMAX.  My first 

flow is “01-import” which contains SEGY Input, Extract Database Files, and 

Disk Data Output.  In the parameters for SEGY Input, I use the file browser to 

locate the SEGY file I want to import.  Next, I set the sort order to SHOT and 

change the maximum number of traces per ensemble to 9999, indicating that 

this number is unknown.  If I knew the exact number, I could set it here, but 

there is a risk that a certain ensemble will have more traces and this would 

result in a truncated ensemble.  Next, I choose to remap the SEGY header 

values because I know that my trace headers do not conform to the SEGY 
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Revision 1.0 standard.  The two headers I have to add are SOU_SLOC and 

SRF_SLOC, which are the source and receiver location numbers, respectively. 

Once I have set the parameters for SEGY Input, I set up the parameters 

for Extract Database Files, which will begin building the ProMAX database from 

the trace headers.  I set the data type to land, the source index type to FFID 

(Field File Identification Number), and the receiver index method to coordinates.  

As this extraction is prior to creating the geometry, I set the pre-geometry 

extraction check to yes.  Finally, in Disk Data Output I create a name for the 

output dataset and set the trace sample format to 32 bit. 

The next step after the SEGY file has been imported and written to disk 

in ProMAX’s internal format is to create the geometry in the database.  My next 

flow is “02-geometry” and consists of Disk Data Input, Trace Header Math, 

Database/Header Transfer, and 3D Land Geometry Spreadsheet.  For Disk 

Data Input I select the file I just created in the previous import step.  I use Trace 

Header Math to define the source and receiver line headers (S_LINE and 

R_LINE, respectively) from the source and receiver location numbers 

(SOU_SLOC and SRF_SLOC, respectively).  Next, I transfer the newly created 

trace headers to the database using Database/Header Transfer, setting the 

direction of the transfer as loading from the trace header to the database.  The 

3D Land Geometry Spreadsheet does not have any parameterization. 

A interactive menu appears as 3D Land Geometry Spreadsheet runs.  

The first step is to click Setup and a new menu appears.  I set the midpoint 

assignment method to “Existing index number mappings in the TRC” meaning 
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that the trace database is used to assign midpoints.  I set the nominal receiver 

and station interval to 220.0 and the nominal crossline separation to 660.0.  I 

leave the nominal survey azimuth as it is.  I set the source type to surface 

seismic source as the data was acquired using Vibroseis and the units to feet.  

Then I click ok to exit the setup. 

Next, I click the Receivers menu in the 3D Land Geometry Spreadsheet.  

I see that the station, x, y, elevation, and line columns are all filled.  Because 

the elevation statics are applied, I set the elevation to 1500 ft using the edit 

menu in the receiver spreadsheet.  Then I exit the receiver spreadsheet and 

open the sources spreadsheet.  Again, I set the elevations to 1500 ft.  By 

clicking View > View All > Basemap, I can plot a map of all the sources and 

receivers.  This is useful for determining how many lines are live for any given 

shot.  For my survey, there are 10 live receiver lines per shot, and each receiver 

line has 52 active geophones for 520 traces per ensemble.  I can also see that 

source line 513 was the overlap of the two patches, with some shots recorded 

in patch 1 and some recorded in patch 2.  I close the Basemap view and exit 

the sources spreadsheet. 

Next, I click on Bin which brings up the 3D Binning and QC menu.  The 

first step is to assign the midpoints, so I click this option and click “OK”.  After 

assigning midpoints, I click Define Binning Grid and click “OK”.  This brings up 

XYgraph display.  I click Display > Midpoint > Control Points > White.  This plots 

all of the midpoints as white dots.  Next, I click Grid > Display which brings up a 

small blue grid in the lower left hand corner.  I then click Grid > Parameterize 
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which displays the grid parameters.  I set the azimuth to 358.98 degrees.  The 

cell size along azimuth (dy and dx) are equivalent to the midpoint binning grid 

size, which for this survey is 110 ft by 110 ft, which is what I enter for dy and dx.  

The number of cells along the azimuth (ny) is equivalent to the number of 

crosslines, which I know is 198 from a stacked version of the data.  Similarly, 

the number of cells along the azimuth (nx) is the number of inline which I set to 

402.  Finally, I enter the X and Y origin coordinates, which are 2399729.25 and 

667392.00, respectively.  I click the green stoplight button which creates a grid 

matching these specifications and closes the window.  I now see a blue grid 

that covers all of my midpoints.  I use the zoom tool to check all four corners of 

the survey to ensure that the grid covers all the corners without any midpoints 

falling outside of the grid.  I then use the zoom tool to check several locations 

inside of the grid to ensure that the midpoints fall within the bins and not along 

the bin lines themselves.  With the binning grid satisfactorily defined, I click Grid 

> Save to and give the grid a name.  Then I exit XYgraph. 

With the midpoint grid defined, I click Bin midpoints in the 3D Binning 

and QC dialog.  This brings up the 3D Land Midpoint Binning dialog.  I click the 

“Load” button at the bottom and select the binning grid I defined in the previous 

step.  This loads all my parameters into the menu and I click “Apply”.  After 

midpoint binning is complete, I click “Cancel” to close the dialog. 

Back in the 3D Binning and QC menu, I select QC Bin Data, click the 

“QC Bin Space” button selecting my midpoint grid, and click “OK”.  The default 

QC type is Coordinate Space Fold which will display a fold map.  The other 
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options are Line Space Fold, Spider, and Mid-Points.  Once I am satisfied with 

the midpoint binning, I select Finalize Database and click “OK”.  Once the 

database is finalized, click “Cancel” to exit the 3D Binning and QC dialog. 

I now click TraceQC which brings up a new spreadsheet.  This 

spreadsheet should be entirely filled out with the exception of the FB Pick 

column.  Under the view menu are more options to QC various geometries.  I 

close the spreadsheet and click File > Exit to quit the 3D Land Geometry 

Spreadsheet.  Geometry assignment is now complete, and the next step is to 

apply the geometry in the database to the trace headers of the dataset. 

Before applying the geometry to the data, I first want to test for True 

Amplitude Recovery, define several time gates for Time-Variant Scaling, and 

decide how to define patch 1 and patch 2 for later phase matching.  I create a 

flow for True Amplitude Recovery testing that consists of Disk Data Input, 

Parameter Test, True Amplitude Recovery, and Trace Display.  I select the raw 

input dataset, sorting by Field File Identification Number (FFID) and Absolute 

value of Offset (AOFFSET).  I set the sort order to “*:200-3000/” which means 

get all FFIDs and limit the AOFFSET from 200 to 3000 ft.  I set Parameter Test 

to “2|4|6|8|10|12” for the various dB/sec corrections I wish to test.  I then set 

Apply dB/sec correction to yes in the TAR parameters and enter 99999.0 for the 

correction constant to indicate I want to use values from Parameter Test.  As I 

am testing six correction values, I set the number of ensembles per screen in 

Trace Display to six.  I change the primary and secondary trace labels to match 

my sort order in Disk Data Input.  I then execute the flow.  Trace Display opens 
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and I see six panels in the window, each labeled by the dB/sec correction 

constant it uses.  Each panel uses FFID 1 between 200 and 3000 ft AOFFSET.  

After inspecting each panel, I decide the most balanced panel is between 8 and 

10 dB/sec correction, so I will use a value of 9. 

Next, I want to define a series of time gates for Time-Variant Scaling 

(TVS).  I build a flow consisting of Disk Data Input and Trace Display.  Again, 

the sort order is FFID and AOFFSET, but now I have it set as “*:*” meaning all 

FFIDs and AOFFSETs are used.  I only want one ensemble per screen, so I set 

this value to one and I execute the flow.  In the Trace Display window, I click 

Picking > Miscellaneous Time Gates.  I give the gate the name TVS-FFID and 

select AOFFSET for the secondary header key.  I then proceed to pick four time 

gates with the top of the next gate overlapping the bottom of the previous gate.  

Once I have picked a layer, I use the right mouse button to project the picks and 

then select a new layer.  Once I have finished picking the time gates I click File 

> Save Picks and then exit Trace Display. 

Finally, before I apply the geometry I must decide how to delineate 

records in patch from those in patch 2.  I open DBTools (Database Tools) and 

navigate to the SIN (Source Database) tab.  Then I click View > 2D Matrix.  This 

brings up a window with four selections – Horizontal, Vertical, Color, and 

Histogram.  I select X coordinate for the horizontal axis and Y coordinate for the 

vertical.  Then I choose S_LINE for both color and histogram.  The resulting plot 

shows the source lines as laid out for the survey.  I do the same for the SRF 

(Receivers Database), this time using receiver station (STATION) for color and 
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histogram.  I now have two plots showing the geometry of the source and 

receiver lines. 

There are six icons on the left hand side of the plot window.  The third 

one down allows me to select sources or receivers using an arbitrary polygon.  

The fourth icon down tracks the values when I mouse over the plot and displays 

the values in the bottom portion of the window.  I click the arbitrary selection 

tool in the sources plot window and select source line 513 which I earlier 

identified as the overlap between patch 1 and patch 2.  I then click Project > 

SRF.  This shows that all of the receivers record shots along source line 513.  

Next, I select source lines 514-526 which make up patch 2.  Projecting the SIN 

selection onto the SRF plot, I see that receivers xxx1049-xxx1100 are active for 

source lines 514-526.  I then select source lines 501-512 and project them onto 

the SRF plot.  Receivers xxx1001-xxx1051 are active for source lines 501-512.  

This tells me that receivers xxx1049-xxx1051 overlap for patches 1 and 2.  

From this I determine that patch 1 is defined as source lines 501-513 and 

receivers xxx1001-xxx1051 while patch 2 is defined as source lines 513-526 

and receivers xxx1049-xxx1100.  This information will be used in the geometry 

application step. 

Now that I have finished several intermediary steps, I am ready to apply 

the geometry to the trace headers of the ProMAX dataset.  This allows the trace 

headers to be used to reference the database.  The flow I build for “03-Geom-

Apply” is as follows: Disk Data Input, Inline Geom Header Load, True Amplitude 

Recovery, Time-Variant Scaling, Database/Header Transfer, IF > Trace Header 
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Math > ENDIF, Database/Header Transfer, Trace Header Math, IF > Trace 

Header Math > ELSEIF > Trace Header Math > ENDIF, Database/Header 

Transfer, Disk Data Output.  I select the raw dataset for Disk Data Input and set 

the trace read option to get all traces.  I set the primary header for database 

matching in Inline Geom Header Load to FFID and all other options to No.  I set 

True Amplitude Recovery to apply dB/sec correction with a constant value of 9.  

I use the gate I picked earlier for Time-Variant Scaling.  I use the first 

Database/Header Transfer to load the TRC GEOMETRY AZIMUTH header 

from the database to the trace header as AZIM.  I then set the IF statement to 

exclude values of AZIM between 0 and 179.999.  I then use Trace Header Math 

to calculate azimuths beyond 180 as negative using the equation AZIM=AZIM-

180.  This sets the azimuth to range between +/- 180 instead of 0-360 degrees.  

I then load the TRC GEOMETRY AZIM header I created from the trace header 

to the database.  I use another Trace Header Math to define receiver station 

numbers without the receiver line prefix.  I create a new header I call R_STATN 

and set it equal to the modulo function of SRF_SLOC (Receiver Station Number 

with Receiver Line prefixed) and 10000.  This gives values of 1001-1100. 

Now I begin the process of defining the two patches.  Using an IF 

statement, I include traces with a primary trace header of S_LINE and 

secondary trace header of the newly created R_STATN using an order of “501-

513:1001-1051/”.  As I previously mentioned, this is how I will define patch 1.  I 

then insert a Trace Header Math creating a new trace header I call survey and 

set the included traces to “survey=1”.  Next, I use ELSEIF and include traces 



132 

from primary trace header S_LINE and secondary trace header R_STATN with 

a sort order of “513-526:1049-1100/”.  Again, I follow this with a Trace Header 

Math but this time I use the equation “survey=2”.  I have now defined patches 1 

and 2 based off source lines and receiver stations.  I then use Database/Header 

Transfer in which I load from the trace header to the database, creating a new 

database entry in TRC TRCSTATS SURVEY using the trace header SURVEY I 

created.  Finally, I use Disk Data Output to write the dataset with the geometry 

applied, setting the trace sample format to 32 bit.  Once the flow is finished 

running, the job log should say that the geometry loaded in the trace headers 

matches the database and that trace numbers can be used to reference the 

database. 

I now want to use DBTools to QC my definition of patch 1 and patch 2.  I 

open DBTools selecting TRC and click View > 2D Matrix.  I select CMP X for 

the horizontal axis, CMP Y for the vertical axis, and SURVEY for the color and 

histogram.  The resulting plot shows the two patches split in the middle of the 

survey along the horizontal direction, just as I wanted.  In the histogram, I can 

click on either vertical bar, one of which is at 1 and the other at 2, which allows 

me to select all CMPs falling in either patch 1 or patch 2.  I click on the bar for 

patch 1.  Then I use DBTools to plot source lines and receiver stations just as I 

did earlier.  Using the selection tool in the SURVEY plot, I select all of patch 1 

and project onto both the SIN and SRF plots.  I see that patch 1 is exactly as I 

defined it.  I then click the vertical bar for patch 2 in the SURVEY histogram and 

then use the selection tool to select all of patch 2.  I project the selection onto 
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the SIN and SRF plots, and again patch 2 is exactly as I defined it.  This will be 

important later when I want to phase match patch 1 to patch 2. 

At this point, it is a good idea to examine the spectral content of my data.  

I build a flow I call “view-spectra” which consists of Disk Data Input, Bandpass 

Filter, and Interactive Spectral Analysis.  I input my dataset with geometry 

applied, sorting by SOU_SLOC and AOFFSET.  I pick a single source station of 

5051076 and get all offsets.  I turn off the bandpass filter by right clicking it with 

the mouse.  In the parameters for Interactive Spectral Analysis I set the data 

display to ensembles, and set the primary and secondary trace header labels to 

match the sort order in Disk Data Input.  I then execute the flow. 

The Interactive Spectral Analysis window opens, and there are four 

panels.  The upper left panel is the ensemble which in this case is a shot 

gather.  The lower left panel is an F-X plot.  The upper right panel is the 

frequency plot while the lower right panel shows the phase.  I see that my raw 

gathers with geometry applied has a frequency range of about 15-110 Hz with a 

notch at about 42 Hz and a drop of -10 dB starting at 50 Hz up to 110 Hz.  After 

110 Hz the frequency sharply rolls off.  The default view for the frequency is in 

dB power.  It is also useful to examine the percent power, which can be 

selected by clicking View > Power Spectrum.  I exit the viewer and turn the 

bandpass filter on by right clicking it.  I begin by investigating the low 

frequencies.  I set the bandpass filter as an Ormsby zero phase frequency filter 

with corners of 0-2-22-24 Hz.  Executing the flow brings the interactive viewer 

back up.  I notice that in the selected frequency range, most of the data is 
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ground roll with only a small amount of actual data.  I then set the bandpass 

filter to 20-24-110-120 Hz.  Even with such a severe low cut there is still 

considerable ground roll leaking into the data.  With this in my, I design a 

bandpass of 10-20-90-120 Hz.  This allows me to retain some of the low 

frequency data, but with a gradual ramp from 10 to 18 Hz, minimizing some of 

the ground roll.  Although the data was recorded at a 2.0 ms sample interval 

which translates to a Nyquist frequency of 250 Hz, there appears to be no 

frequency content beyond 120 Hz. 

Next, I build a flow to calculate some trace statistics in order to perform 

some trace edits, called “04-trace-statistics”.  The flow is simple and consists of 

Disk Data Input and Trace Statistics.  I read in the data with geometry applied 

and set the trace read option to get all traces.  For the types of trace statistics to 

compute, I select TRCAMP, SPIKES, FRQ_PK, FRQ_DV, and ADECAY.  

TRCAMP is the average trace energy.  SPIKES is a measure of the spikiness of 

the data, defined as the maximum amplitude divided by the average amplitude.  

FRQ_PK measure the peak frequency of the data while FRQ_DV measures the 

statistical deviation of the frequency.  ADECAY is a measure of the estimated 

energy decay rate of the data.  I chose YES to get the analysis gate from the 

database and see that I need to pick one.  I fire up a trace display using FFID 

and AOFFSET and select Picking > Pick Miscellaneous Time Gates.  I call it 

TRCSTATS and select AOFFSET as the secondary key.  I pick the top of the 

gate slightly above the first breaks, following the contour of the first breaks, 

project it by right clicking the mouse and then create a new layer.  The second 
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layer I pick across the bottom of the data as a flat layer.  I then save the picks 

and exit the trace display.  I can now select the time gate table I just picked and 

then execute the flow. 

While I wait for the trace statistics to run, I decide to pick a top mute.  I 

want to use about four or five shot gathers to check for spatial variability.  I use 

DBTools and create a 2D matrix plot of the source index numbers by x and y 

coordinates.  I use the mouse tracker to pick out five locations, one in the mid-

section of each corner and one in the center of the survey.  I take note of the 

source numbers for a view shots flow.  This flow consists of Disk Data Input and 

Trace Display.  I set the primary trace header key to Live Source Number (SIN) 

and the secondary trace header key to Recording Channel Number (CHAN).  

My sort order list is “5051305, 5041061, 5151199, 5201341, 5211079:*/” which 

is the five shots I selected an all channels for each shot. 

In the trace display window, I click Picking > Pick Top Mute.  I call the 

mute table “Top Mute” and set the secondary key to AOFFSET, even though I 

used recording channels in the sort order.  I see ten records, one for each cable 

that is live for the shot.  A flag identifies the receiver cable that is collocated with 

the shot for that particular record.  I put a pick at the top of the cone for this 

cable, and make another pick at the base of the cone on one side.  I then right 

click the mouse and click project, which projects this pick for the entire shot 

across all cables.  If the geometry is properly applied, the project pick will follow 

the contour of each record within the shot.  Pleased with the pick, I save it and 

click the arrow to go to the next shot to check how the project pick holds up.  
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Once I am satisfied that the pick does well for shots in different parts of the 

survey, I save once more and exit.  Back in the flow parameters, I change the 

secondary trace header key from CHAN to AOFFSET and restart the flow.  I 

then click Picking > Pick Top Mute and select the mute I just picked. This is 

another way to QC the top mute pick.  I am pleased with it, so I can now move 

on. 

By now, my Trace Statistics flow is complete.  I open DBTools to 

examine the output.  First, I will look at the average trace energy, TRCAMP.  I 

select the TRC order and click View > 2D Matrix.  I choose TRC for the 

horizontal axis and TRCAMP01 for vertical axis, color, and histogram.  Using 

the histogram, I can see the distribution of my data and click and drag the 

mouse to select a desired range.  The plot will change according to the 

histogram selection.  This allows me to pick a range that contains most of the 

data except outliers, giving a smooth, squared appearance to the plot.  I take 

note of the limits I choose.  I do this also for the remaining four statistics I 

calculated. 

Next, I create a flow called “04b-trace-editing”.  The flow begins as Disk 

Data Input, Database/Header Transfer, and Trace Display.  However, I will add 

several Trace Kill/Reverses in a minute to see the effect of trace editing.  I 

select the raw data with geometry applied and sort by CMP bin number and 

AOFFSET.  I choose a single CMP for the moment at a location in which I know 

the fold is high (this can easily be done using DBTools) and all the offsets for 

that CMP.  Therefore, my sort order list looks like “73804:*/”.  Next, I need to 
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transfer the trace statistics I calculated from the database to the trace headers.  

I set the number of parameters to five, and begin selecting the database 

statistics.  For example, the first database parameter is “TRC TRCSTATS 

FRQ_DV01” and the first header entry is “FRQ_DV01”.  I do this for the 

remaining four statistics.  I set the primary and secondary trace header labels in 

Trace Display to match my sort order of CMP bin number and AOFFSET.  Then 

I execute the flow.  This will simply transfer the statistics and display the CMP 

gather without any edits applied. 

I minimize the trace display so I can compare subsequent edited displays 

with the unedited gather.  After the Database/Header Transfer, I insert a Trace 

Kill/Reverse.  I set it to Kill and select SPIKINESS as the primary edit list header 

word.  From the DBTools 2D Matrix plot, I decide to kill traces that have a range 

above 100 for SPIKINESS, so I set the edit list as 101-9999.  I then execute the 

flow.  The changes are not drastic but that is OK.  I do not want to over-edit the 

traces.  I simply want to eliminate the spikiest traces.  I can use DBTools to 

view the effect of eliminating traces with spikiness over 100.  If I want to be 

more heavy handed, I could set the Trace Kill/Reverse to kill traces with 

spikiness over 50-60. 

Although I have calculated five trace statistics, I will only use two to three 

for performing trace edits.  Now that I have a handle on what I want to use for 

editing spikiness, I add a second Trace Kill/Reverse and this time I set it to kill 

based on TRCAMP, the average trace energy.  Using DBTools, I decide to kill 

traces from 0-0.09 and 1.69-99999.  This statistic has more of a Gaussian 



138 

distribution and I am cutting off the fringes.  Again, I view the result in using the 

trace display and the result is not drastic, but there are places where careful 

inspection shows improvement.  If I wanted a more drastic result, I would 

choose to kill from 0-0.6 and 1.6-99999. 

The final trace statistic I decide to use for editing is FRQ_DV, the 

statistical deviation of the frequency.  This statistic is very Gaussian in 

distribution and again I kill the fringes.  I set the edit list as “0-1.4, 10.6-99999/”, 

killing the fringes where there is little data.  This kills several traces 

overwhelming dominated by groundroll.  I finish the flow by turning off the trace 

display and adding a Disk Data Output at the end.  I give the output dataset a 

filename of “geom-apply-trc-ed” and set the trace sample format to 32 bit.  I 

change the sort list in Disk Data Input to include all the CMPs and then I 

execute the flow. 

Before I proceed any further, I want to QC the refraction statics 

previously applied to the raw data.  I use a Trace Display flow, sorting by SIN 

and CHAN, using SIN 5071060.  In the display, I use the DX/DT tool to 

measure the approximate velocity of the first breaks, which is around 11,200 

ft/sec for this shot.  I close the display and build a flow called “05-qc-previous-

refr-statics”.  The flow contains Add Flow Comment (sources), Disk Data Input, 

Automatic Gain Control (AGC), Linear Moveout Correction, CMP/Ensemble 

Stack, Trace Display, Add Flow Comment (receivers), Disk Data Input, 

Automatic Gain Control, Linear Moveout Correction (LMO), CMP/Ensemble 

Stack, and Trace Display.  The idea behind this flow is create an ensemble 
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stack along a source line and along a receiver line, applying a linear moveout 

correction using the first break velocity, and if the first breaks are flat and 

smooth, the refraction statics are properly applied.  Stacking along the source 

line gives us the refractors.  This method was suggested to me after discussing 

various methods to check previously applied refraction statics with my 

colleague Oswaldo Davogustto. 

The first half of the flow is for the source line ensemble stack.  I read in 

the dataset with geometry applied after the trace edits, setting the primary sort 

key to SOURCE and the secondary sort key to S_LINE.  I get all the shots (*) 

for S_LINE 504.  Next, I apply AGC, keeping the default parameters.  I then 

apply an LMO correction using the velocity I estimated from the first breaks in 

the trace display window.  It is a forward correction.  I set the primary header 

key to SOURCE and the secondary header key to AOFFSET.  The format for 

the velocity parameter list is SOURCE:OFFSET:VELOCITY.  Therefore, my 

parameter list is “5071060:0:11200/”, meaning I choose SOURCE 5071060 at 0 

ft AOFFSET (or the nearest offset to 0 ft) and a first break velocity of 11,200 

ft/sec.  Next, I use CMP/Ensemble stack, setting the sort order to SHOT and 

indicating that NMO is not applied.  Then I use trace display to view the 

ensemble stack along the source line. 

The second half of the flow is identical to the first half, except changing 

source-specific parameters to receiver-specific parameters, e.g., SOURCE 

header key becomes Receiver Index Number, and CMP/Ensemble Stack is in 

Receiver sort order.  I do not, however; change the parameters for LMO.  Both 
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stack are flat and smooth so I can conclude that the previously applied 

refraction statics are sufficient. 

Next, I build a flow called “06-prelim-decon”.  I use this flow to create a 

deconvolved dataset before phase matching patch 1 and patch 2.  The flow 

consists of Disk Data Input, Trace Muting, Spiking/Predictive Decon, Air Blast 

Attenuation, AGC, Bandpass Filter, and Disk Data Output.  I read in the 

geometry-applied trace-edited dataset with the trace read option set to get all 

traces as it is already in CMP order.  Next, I use Trace Muting to apply the top 

mute I picked several steps back.  I set Spiking/Predictive Decon to Zero phase 

spiking deconvolution with a 120 ms operator length and 0.1% additive white 

noise.  I select the deconvolution gate I picked earlier.  For Air Blast 

Attenuation, I set the velocity to be attenuated as 1100 ft/sec starting at 0.0 ms 

at zero offset.  When testing this parameter it is handy to first set it to mute, 

switching to attenuation after determining the correct parameters.  Here I have 

set it to attenuation.  I keep the default parameters for AGC.  I set Bandpass 

Filter as an Ormsby bandpass zero phase frequency filter with corners of 10-20-

90-120 Hz.  I then write out the dataset as “prelim-decon” with a 32 bit trace 

sample format. 

Once is complete, I view the output deconvolved dataset using a flow 

called “view-CMP”.  This flow consists of Disk Data Input and Trace Display.  

Disk Data Input is set to read “prelim-decon”.  The primary sort key is CMP bin 

number and the secondary sort key is AOFFSET.  I pick a single CMP in the 

center of a high-fold zone for the sort list, which in this case is “71208:*/”.  The 
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default display window size is too large for viewing CMP gathers, so I shrink the 

window horizontally until I am pleased with the view.  I can see events fairly well 

down to almost 800 ms.  The deconvolution has also done a good job of 

handling groundroll.  Later, I will use surface-consistent spiking deconvolution 

on the geometry-applied trace-edited dataset after I have phase matched patch 

1 and patch 2. 

I also want to have an idea of what the deconvolution has done to the 

spectral content of my data, so I exit the viewer and return to my “view-spectra” 

flow.  I turn off the bandpass filter, switching Disk Data Input to read “prelim-

decon”.  I keep the sort order at SOU_SLOC and AOFFSET so I can get a 

better view of the data.  I see that frequencies still lie mostly between 15-110 

Hz.  However, thanks to the deconvolution operation, the spectra are 

considerably flatter.  There is still a noticeable notch at 40 Hz, but it is not as 

drastic as I observed with the raw data. 

A handy flow to go ahead and build is “header-value-range-scan”, which 

scans all the trace headers for an input dataset and displays the minimum and 

maximum values for each trace header encountered in the job run log.  The 

flow consists of Disk Data Input and Header Value Range Scan.  I choose 

“prelim-decon” and leave the trace read option as get all traces.  I select to 

process only the trace headers.  Header Value Range Scan is parameterless.  I 

open the job run log and select the option to monitor.  I will keep this log open 

as I will need to reference it momentarily. 
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Now that I have a deconvolved dataset, I am ready to begin velocity 

analysis and calculating residual statics.  I build a flow called “07-brute-stack”.  

The flow consists of 3D Supergather Formation, AGC, Bandpass Filter, Velocity 

Analysis Precompute, Disk Data Output, Disk Data Input, Velocity Analysis, 

Volume Viewer, Add Flow Comment (separator between velocity analysis and 

residual statics calculation), Disk Data Input, NMO Correction, Bandpass Filter, 

Disk Data Output, 2D/3D Max. Power Autostatics, Disk Data Input, Apply 

Residual Statics, Stack 3D, Time-Variant Scaling, and Disk Data Output.  I 

begin with 3D Supergather Formation through the first Disk Data Output.  I turn 

off everything else in the flow by highlight each process and right clicking. 

For the brute stack, I wish to use a single point for velocity analysis.  

Using DBTools, I create a 2D matrix plot of CMP fold to get an idea of where to 

pick a point.  Typically, a point in the center is ideal, however; because the 

center of my survey is the edge of two patches, fold is very low in the center.  I 

then choose a point slightly off center in patch 1 at inline 186 and crossline 148.  

I close DBTools and return to the brute stack flow and begin parameterizing 3D 

Supergather Formation.  I select to use “prelim-decon” and presort in memory.  

My maximum CMP fold is 186, and location selection is by grid.  I set the 

minimum and maximum center inline number to 186 and keep the inline 

increment at 10, which will have no effect in this 1 point analysis.  I combine 3 

inlines.  Then, I set the minimum and maximum crossline number to 148, with 

the increment kept at 15.  I combine 3 crosslines.  I keep the default AGC 

parameters.  I use the same parameters for Bandpass filter as in previous flows 
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– Ormsby bandpass zero phase frequency filter with corners of 10-20-90-120 

Hz. 

Next, I parameterize Velocity Analysis Precompute.  As I am combining 3 

inlines and 3 crosslines for supergathers, I set the number of CMPs to sum into 

a gather as 9.  The next parameter I set is the absolute offset of the first bin 

center.  I refer to the job run log from Header Value Range Scan and see the 

value for this is 55.0.  I enter 220.0 as the bin size for vertically summing 

offsets, which is the receiver group spacing.  The maximum offset is read in 

from the database, and I choose to use this value.  I set the minimum 

semblance analysis velocity to 5000.0 ft/sec and the maximum to 25000 ft/sec.  

I then change the number of semblance calculations to 101.  I set the number of 

stack velocity functions to 19 to give me more velocity functions to test, and the 

number of CMPs per stack strip to 9 to equal the number of CMPs summed into 

a supergather.  I change the method of computing velocity functions to 

percentage and set the percent maximum at 30.0.  As this is the first round of 

velocity analysis, I do not have a previous table I can use as a guide function, 

so I set the option to “No” and enter 5000.0 and 25000.0 ft/sec for the minimum 

and maximum guide values.  I keep the NMO stretch mute at 30.0% and do not 

choose to apply a long offset correction.  As I already applied my top mute to 

my deconvolved data, I keep the option as “NONE”.  Finally, I output the 

precomputed data using Disk Data Output, saving it as “brute-velo-pc” using a 

32 bit trace sample format.  I click execute and let the first part of the flow run. 
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Once the precomputed dataset is written, I turn off the first part of flow 

and turn on the first Disk Data Input and Velocity Analysis.  I select “brute-velo-

pc” as the input dataset, change the trace read option to sort and select 

Supergather Bin Number (SG_CMP) as the primary trace header key.  In 

Velocity Analysis, I click the button next to the velocity table selection.  I then 

create a new table to store my picks and call it “velo-brute”.  Instead of getting 

the guide function from an existing table, I use the same parameters I used in 

the precompute stage.  I also turn off the stretch mute for NMO by setting it to 

0.0 as I like to first pick velocities without any stretch muting.  The target zone is 

shallow at about 580 ms, so turning off the stretch mute gives me a better 

indication of whether I am under or over correcting for hyperbolic movement.  

After I have picked the velocities, I go back and set the stretch mute at 30% and 

check the corrected gathers in the interactive velocity analysis display.  Once I 

have set these parameters, I click execute.  This brings up the velocity analysis 

window.  The display can be adjusted either within the window or by setting the 

option to set visible items to “Yes” in the parameters.  I like to turn off the 

semblance contours and the guide function and turn on NMO animation, the 

dynamic stack, the interval velocity function, and the velocity color background.  

I have set the brute stack velocity analysis to use a single location.  Once I have 

finished picking the velocities for this supergather, I click File > Save Picks. 

Leaving the velocity analysis window open, I return to the parameters 

and turn off Disk Data Input and Velocity Analysis and turn on Volume 

Viewer/Editor.  I set the input volume as “velo-brute”, the table in which my 
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current pick is saved.  I leave all the other parameters as they are and click 

execute.  After a moment the Volume Viewer Cross-Section and Map windows 

appear.  I see a nicely stratified velocity field in the cross section.  If I click the 

bottom button in each window, the analysis location is displayed in the map and 

cross-section views.  I will use the Volume Viewer/Editor more extensively later 

in my processing flows.  However, for now I simply close the viewer and the 

velocity analysis window. 

With velocity analysis for the brute stack completed, I turn off Volume 

Viewer/Editor and turn on Disk Data Input to the Disk Data Output before 2D/3D 

Max. Power Autostatics.  For the Disk Data Input I select “pelim-decon”.  I then 

set up NMO Correction to use “velo-brute” as the velocity parameter file, leaving 

the 30.0% stretch mute on.  I set Bandpass Filter as an Ormsby bandpass zero 

phase frequency filter with corners of 10-20-90-120 Hz.  I then set Disk Data 

Output to create a new dataset called “brute-nmo” with a 32 bit trace sample 

format.  I turn off the processes I just ran and turn the remaining processes in 

the flow on. 

I need to pick an Autostatics horizon before I can continue 

parameterizing 2D/3D Max. Power Autostatics.  I build a new flow called “pick-

ahz” which contains Disk Data Input, Stack 3D, Inline Sort, and Trace Display.  I 

select “brute-nmo” as the input volume to Disk Data Input and set the trace read 

option to sort.  I set the primary header key as ILINE_NO and the secondary 

header key to XLINE_NO.  I need the first and last inlines and all crosslines to 

define a horizon that spans the volume.  Therefore, my sort order list is 
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“1,402:*/”.  I do not change any parameters for Stack 3D.  I set the primary sort 

key for Inline Sort to ILINE_NO and the secondary sort key to XLINE_NO.  I 

also change the maximum number of traces from 186, the CMP maximum fold, 

to 198, the number of crosslines within an inline.  I then set the trace labels in 

Trace Display as ILINE_NO for the primary label and XLINE_NO for the 

secondary label.  Even though I am only inputting data from the first and last 

inlines, Stack 3D will also create all the inlines in between so I set the ensemble 

increment to 401 so I can skip immediately to the last inline.  I then execute the 

flow. 

Once the trace display appears, I see the first inline and 198 crosslines.  

The stack section does not look like much right now, but that is fine.  This is, 

after all, a brute stack, and the analysis location was far away from the first 

inline.  I click Picking > Pick Autostatics Horizons.  A menu pops up asking me 

to name the horizon.  I name it and click OK.  Another window appears with two 

options.  The first is smash and the second is gate width.  I set the smash to 9 

to match the number of CMPs I combine in supergather formation and set the 

width to 1000.  Now I am able to pick the horizon.  I make the first pick at 

ILINE_NO 1 and XLINE_NO 1 at 1000 ms.  My next pick is at ILINE_NO 1 and 

XLINE_NO 198 at 1000 ms.  I then click to go to the next ensemble which is the 

final inline.  I make a third pick at ILINE_NO 402 and XLINE_NO 1 at 1000 ms 

and a fourth pick at ILINE_NO 402 and XLINE_NO 198.  I then right click with 

the mouse and click Project.  I then click File > Save Picks and exit the trace 

display.  I now continue to parameterizing 2D/3D Max. Power Autostatics. 
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The next step is to parameterize 2D/3D Max. Power Autostatics.  I select 

“brute-nmo” as the input trace data file.  I select my newly created Autostatics 

horizon file.  I change the number of iterations to 6 and the minimum number of 

live samples in a gate to 30.0%.  I set the maximum statics allows to 12.0, 16.0, 

20.0, 24.0, 28.0, and 32.0.  Because I have selected to have 6 iterations, I have 

to have 6 different values here, as well.  I then set the correlation reject percent 

to 30.0%.  I set the final minimum static to -32.0 and the final maximum static to 

32.0 to match the final value in my list above.  For the first run I keep the Run ID 

at 0000.  Next, I use Disk Data Input to read “brute-nmo”.  I add Apply Residual 

Statics, keeping the default parameters.  As I run more iterations of Max. Power 

Autostatics, I will change the Run ID, and I will have to change the naming 

mode to reflect this.  Next I use Stack 3D, keeping the default parameters.  

Next, I use Time-Variant Scaling using the gates I picked earlier.  Finally, I 

output the stacked data as “stack-brute” with a 32 bit trace sample format.  

Running 2D/3D Max. Power Autostatics takes time, so now I wait. 

Once the flow is finished, I can view the residual statics using DBTools.  

First, I will view the residual statics applied to the sources.  I create a 2D Matrix 

plot using the SIN database.  I choose X coordinate for the horizontal axis and 

Y coordinate for the vertical axis.  I then select SPWR0000 for both color and 

histogram and click OK.  I see that after the first run of residual statics, the 

majority of the corrections to the sources are within +/- 2.0 ms.  Ideally, I want 

the solution to converge to 0.0 ms, but if I can within less than +/- 1.0 ms I will 

be satisfied.  I do the same for the receiver statics using the SRF database, this 
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time selecting RPWR0000 for color and histogram.  Again, my residual static 

corrections for the receivers are mostly between +/- 2.0 ms. 

Next, I wish to view the NMO corrected CMP gathers.  I open my “view-

CMP” flow and select “brute-nmo” as the input volume.  I then execute and the 

trace display window appears.  I can see some strong, flat events between 300 

and 800 ms, with groundroll and noise overpowering whatever signal may be 

present below 1000 ms.  I also want to view the stack, so I create a new flow 

called “view-stack” consisting of Disk Data Input and Trace Display.  I read in 

“stack-brute”, setting the trace read option to sort.  I set the primary key to 

ILINE_NO and the secondary key to XLINE_NO.  My sort list is “20-380(10):*/”, 

meaning I want inlines 20 through 380 incremented by 10 and all crosslines.  

The stack appears in the trace display window and I can move through.  

Already I am able to see events resolving, and as I move closer to areas of 

better fold, the stack section improves. 

Now that I have made a brute stack, I will continue velocity analysis with 

an 80x80 grid, followed by a 40x40, 20x20, and finally a 10x10 grid.  Each flow 

will be close to identical to the flows I used creating the brute stack.  However, I 

will split the velocity analysis and residual statics calculation into two separate 

flows for convenience.  The major changes are to the inline and crossline 

increments in 3D Supergather Formation, and changing the tables for storing 

velocity picks, and the addition of Apply Residual Statics from previous runs.  I 

will detail this for the 80x80 velocity analysis and residual statics flows. 
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I make a new flow called “08-velo-80x80”.  The flow consists of 3D 

Supergather Formation, Apply Residual Statics, Air Blast Attenuation, 

Automatic Gain Control, Bandpass Filter, Velocity Analysis Precompute, Disk 

Data Output, Disk Data Input, Velocity Analysis, and Volume Viewer/Editor.  I 

begin with with the last three turned off and everything else turned on.  I select 

“prelim-decon” as the input dataset for 3D Supergather Formation.  I set the 

minimum center inline to 40 and the maximum center inline to 400, with an 

increment of 80.  I then set the minimum center crossline to 40 and the 

maximum center crossline to 198 with an increment of 80.  This 80x80 inline-

crossline increment is why I call this “velo-80x80”.  I still combine 3 inlines and 3 

crosslines for a supergather smash of 9 CMPs.  I keep the defaults for Apply 

Residual Statics so it grabs the first Run ID of 0000.  I use Air Blast Attenuation 

with the same parameters I have used in previous flows.  I use AGC with the 

default parameters, as they give desirable results.  I set Bandpass Filter with 

the same parameters I have been using.  The parameters for Velocity Analysis 

Precompute are identical to the parameters in the “07-brute-stack” flow, with the 

exception that I choose to get the guide function from an existing parameter 

table and select “velo-brute”.  I then create a new output dataset in Disk Data 

Output called “velo-80x80-pc” with a 32 bit trace sample format.  I then run the 

flow. 

Once the precompute step is complete, I turn off everything in the flow 

and then turn on Disk Data Input and Velocity Analysis.  I set Disk Data Input to 

read in “velo-80x80-pc” with the trace read option set to sort and a primary 
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header key of SG_CMP.  The parameters for Velocity Analysis are identical to 

those found in the “07-brute-stack” flow, except I have changed the table to 

store picks to a newly created “velo-80x80” and I use “velo-brute” as the guide 

function. 

I execute the flow and the velocity analysis window appears.  I begin 

picking points for the first analysis location.  Once I have picked points for the 

first location, I save the picks, keeping the velocity analysis window open.  I 

then return to the flow editor and turn off Disk Data Input and Velocity Analysis 

and turn on Volume Viewer/Editor.  I pick “velo-80x80” for the input volume.  I 

then select “Yes” to display poststack seismic data, picking “stack-brute”.  Then 

I run the flow.  The Volume Viewer Cross-Section and Map windows appear.  

Clicking the bottom button displays the analysis locations in the Volume Viewer.  

I continue picking velocities in the analysis window and using the volume viewer 

to QC the velocity field.  I want the velocity field to look smooth and layered, 

without any strange closures.  Once I am done picking velocities, I click File > 

Save Picks and exit the flow.  Each time I advance to the next CMP, the picks 

save auotmatically, but it never hurts to save the picks manually. 

Next, I create a flow called “08b-residual-statics-80x80”.  The flow here is 

identical to the residual statics portion of “07-brute-stack”, except I have added 

an Apply Residual Statics after the initial Disk Data Input.  The full flow is as 

follows: Disk Data Input, Apply Residual Statics, Air Blast Attenuation, AGC, 

Bandpass Filter, NMO Correction, Disk Data Output, 2D/3D Max. Power 

Autostatics, Disk Data Input, Apply Residual Statics, Stack 3D, Time-Variant 
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Scaling, and Disk Data Output.  I keep everything through 2D/3D Max. Power 

Autostatics on and turn off everything else. 

I set Disk Data Input to read “prelim-decon”.  I keep the default settings 

for Apply Residual Statics.  I use the same parameters I have been using for Air 

Blast Attenuation, AGC, and Bandpass Filter.  I set NMO Correction to use 

“velo-80x80” for the velocity parameter file.  I then write out the NMO corrected 

gathers using Disk Data Output as “nmo-80x80”.  I then select “nmo-80x80” as 

the trace data file for 2D/3D Max. Power Autostatics.  I select my same 

Autostatics horizon file as before.  I keep all the other parameters the same as 

in the “07-brute-stack” flow, except I change Run ID to 0001.  If Run ID is not 

changed, it will overwrite the previous residual statics calculation, which I wish 

to keep.  I then run the flow, which takes some time. 

Once 2D/3D Max. Power Autostatics is completed, I decide to use 

DBTools to view the source and receiver residual statics.  This time I will select 

SPWR0001 in the SIN database and RPWR0001 in the SRF database.  My 

source residuals are now mostly between +/- 1.0 ms, which is below the seismic 

sample interval of 2.0 ms.  The receiver residuals are also mostly between +/- 

1.0 ms. 

Using my “view-CMP” flow, I also want to look at the NMO corrected 

gathers after the 80x80 velocity analysis.  I read in “nmo-80x80” using Disk 

Data Input.  I can see more flattened events between 200 and 900 ms, almost 

down to 1000 ms.  Groundroll and noise are still present below 1000 ms, but 

less prevalent. 
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Once the flow has completed, I turn off everything that is on, and turn on 

the Disk Data Input after Autostatics to the final Disk Data Output.  I select 

“nmo-80x80” as the input dataset to Disk Data Input.  I then change the 

database entry naming mode for Apply Residual Statics to “No”.  I click on the 

button next to source residual statics and select “SIN STATICS SPWR0001”, 

and for the receiver residual statics, I select “SRF STATICS RPWP0001”.  I 

then use Stack 3D with the default settings, followed by Time-Variant Scaling 

using my time gates I picked.  I then output the stack using Disk Data Output, 

naming the dataset “stack-80x80” and use a 32 bit trace sample format.  Then I 

run the flow. 

Once the flow has completed, I use my “view-stack” flow to examine the 

stack after 80x80 velocity analysis.  I read in “stack-80x80” sorting by ILINE_NO 

and XLINE_NO.  I continue to use my “20-380(10):*/” sort order list to get 

inlines 20-380 incremented by 10 and every crossline.  The stack looks much 

better now.  I see more events that are continuous and in areas of higher fold I 

am beginning to really resolve some finer details.  I am also beginning to 

resolve some structure in the basement sub-1000 ms, which is quite exciting. 

Now that I have completed two rounds of velocity analysis, I decide to 

phase match patch 1 to patch 2.  I build a new flow called “09-phase-matching”.  

There are three sections to this flow and I begin each one with an Add Flow 

Comment to delineate one from the next.  The first section of the flow is as 

follows: Add Flow Comment, Disk Data Input, Apply Residual Statics, Apply 

Residual Statics, Air Blast Attenuation, AGC, Bandpass Filter, NMO Correction, 
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Stack 3D, Time Variant Scaling, and Disk Data Output.  I begin by reading in 

“prelim-decon” in Disk Data Input.  The sort order uses three header keys.  The 

primary header key is CMP bin number, the secondary header key is 

AOFFSET, and the tertiary header key is SURVEY.  The sort list is “*:*:1/”, 

indicating that I am getting all CMPs and AOFFSETs for patch number 1.  I then 

use two Apply Residual Statics to apply both the statics after the brute velocity 

analysis (Run ID 0000) and the 80x80 (Run ID 0001) velocity analysis.  Air 

Blast Attenuation, AGC, and Bandpass Filter all use the same parameters as in 

previous flows.  NMO Correction uses “velo-80x80”.  Stack 3D uses the default 

parameters, and I use my time gate file for Time Variant Scaling.  I write out the 

data as “stack-surv-1” with a 32 bit trace sample format.  The second section of 

the flow is identical to the first section, with the exception that the sort list in 

Disk Data Input is “*:*:2/” to get all CMPs and AOFFSETs for patch 2 and the 

output is “stack-surv-2”. 

The final section of this flow consists of Disk Data Input, Disk Data Input, 

Derive Match Filter.  The First Disk Data Input reads in “stack-surv-2” while the 

second Disk Data Input reads in “stack-surv-1”.  Derive Match Filter is set to 

use an L2 Norm filter.  The match filter length is set to 400 ms, and the analysis 

window starts at 200 ms and ends at 700 ms.  The entire flow can be ran at 

once.  I choose to read in “stack-surv-2” first because patch 2 has a more even 

fold distribution than patch 1.  While the flow runs, I monitor the job run log.  

Once the process is over, the match filter prints to the log a time shift, a phase 

shift, amplitude gain, and the correlation coefficient.  To phase match patch 1 to 
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patch 2, it must be rotated -50.47 degrees with no time shift.  The correlation 

coefficient is 48.2%. 

Next, I want to examine “stack-surv-1” and “stack-surv-2”.  I open my 

“view-stack” flow and read in “stack-surv-1” first.  I can see that the patch has 

been properly defined and that only traces from patch 1 are present in this part 

of the survey.  I have the same observation for “stack-surv-2”.  Next, I want to 

compare the full stack before and after I apply the phase rotation to patch 1.  I 

build a new flow called “09b-phase-stack”.  The flow consists of Disk Data Input, 

Apply Residual Statics, Apply Residual Statics, IF, Phase Rotation, ENDIF, Air 

Blast Attenuation, AGC, Bandpass Filter, NMO Correction, Stack 3D, Time 

Variant Scaling, and Disk Data Output.  I read in “prelim-decon”, getting all 

traces.  I then apply both passes of residual statics.  I set the IF statement to 

include traces from primary header key SURVEY and specify 1 in the trace list.  

In Phase Rotation, I set the rotation angle to -50.47 and then use ENDIF to 

denote the end of the conditional statement.  Air Blast Attenuation, AGC, and 

Bandpass Filter use the same parameters from previous flows.  NMO 

Correction uses “velo-80x80” and Stack 3D uses the default parameters.  Time 

Variant Scaling uses my picked time gates, and I write out the data as “stack-

80x80-phase-rot”.  

Now that I have created a stack with the phase rotation applied to patch 

1, I want to compare the stack before and after the phase rotation.  I create a 

flow called “compare-inlines”.  The flow contains Disk Data Input, Disk Data 

Insert, Inline Sort, and Trace Display.  I read in “stack-80x80” using Disk Data 
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Input, sorting by ILINE_NO and XLINE_NO and I set the sort list to get only one 

inline, “360:*/”.  I read in “stack-80x80-phase-rot” using Disk Data Insert, setting 

it to insert after the previous traces.  I set the sort and sort list to be the same as 

in Disk Data Input.  I then use Inline Sort, setting the primary header key to 

ILINE_NO, the secondary header key to SEQ_NO, and the tertiary header key 

to XLINE_NO.  This allows me to separate the traces from the two datasets.  I 

then use Trace Display, setting the labels to ILINE_NO and XLINE_NO.  I then 

execute the flow. 

Once the display window appears, I first see the inline from the stack 

prior to any phase rotation.  I then click the next button to go to the inline from 

the stack after phase rotating patch 1.  I can use the animate tool, which is the 

fifth button down on the left.  This brings up a dialog window to control 

animation between the two stack images.  I set it to manual and use the button 

that has two arrows pointing away from each other and a dot in the center.  This 

allows me to toggle between the two images.  I see that after phase matching 

patch 1 to patch 2, the reflectors are much better aligned and the “tear” or seam 

between the two patches is much less prevalent.  I then exit the display. 

Now, I am almost ready to use surface consistent deconvolution on my 

geometry-applied trace-edited data.  However, I first want to test a few more 

noise attenuation processes.  I build a new flow called “10a-noise-attenuation”.  

The flow is as follows: Disk Data Input, Apply Residual Statics, Apply Residual 

Statics, Trace Muting, Air Blast Attenuation, Time Variant Spectral Whitening, 

Time Variant Scaling, and Trace Display.  I read in “prelim-decon” and set the 



156 

sort order to CMP bin number and AOFFSET.  I set the sort order list to get a 

subset of the CMPs and a all of their AOFFSETs (71180-71220:*/).  As before, I 

apply both passes of residual statics.  I already know the effect of using my top 

mute in Trace Muting and the effect of Air Blast Attenuation.  I then set up Time 

Variant Spectral Whitening (TVSW) to balance between frequencies 10,18,110, 

and 120.  I use my picked time gates for Time Variant Scaling (TV Scaling).  

When the display window appears, I can see that the combination of TVSW and 

TV Scaling has significantly improved the signal-to-noise ratio (SNR) of my 

data.  I am now able to see events all the way down to almost 1200 ms at CMP 

71208. 

Now that I have tested some noise attenuation parameters, I am ready to 

create a flow called “10b-scdecon”.  The flow consists of Disk Data Input, IF, 

Phase Rotation, ENDIF, Trace Muting, Surface Consistent Deconvolution, Air 

Blast Attenuation, Time Variant Spectral Whitening, Time Variant Scaling, 

Bandpass Filter, and Disk Data Output.  I elect not to apply residual statics in 

the flow and instead will apply them individually in the proceeding flows.  I read 

in “geom-apply-trc-ed” with the read option set to get all traces.  I set up IF > 

Phase Rotation > ENDIF exactly the same as in “09b-phase-stack”.  The noise 

attenuation parameters are set up exactly the same as in “10a-noise-

attenuation”, and the Bandpass Filter at the end uses the same parameters 

from previous flows.  Disk Data Output creates a dataset called “scdecon-5-gs-

iters”. 
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Surface Consistent Deconvolution reads in the starting and ending CMPs 

from the database.  As my dataset is 17 GB in disk space, I decide to set the 

process to use the disk version as opposed to the memory version.  I select my 

“decon” time gate I picked earlier.  I set the type of deconvolution as spiking.  I 

use the default settings for the components of spectral decomposition (SHOT, 

RCVR, OFFSET, CMP) and for the spectral decompositions used in the 

application of the deconvolution (SHOT, RCVR).  I decide to limit the offsets 

used to calculate the deconvolution operator as the documentation suggests 

this may lead to a better operator.  I set the minimum offset to 500 ft and the 

maximum offset to 3500 ft.  I use a 120 ms operator length with 0.1% additive 

white noise.  I then change the number of Gauss-Siedel iterations from the 

default 3 to 5.  The documentation notes that Cary and Lorentz (1991) 

recommend using 5 Gauss-Siedel iterations during the spectral decomposition 

phase.  Once I am done parameterizing the flow, I execute and let it run.  This 

flow takes a while to run. 

Once the flow is finished, I open my “view-CMP” flow and read in 

“scdecon-5gs-iters”.  The combination of noise attenuation and surface 

consistent deconvolution (SC decon) has dramatically improved the SNR of the 

data.  I can now see hints of events even below 1200 ms, especially at near 

and far offsets.  I exit the viewer and open the flow “view-spectra” to examine 

how the noise attenuation processes and SC decon have affected the data’s 

spectra.  Between frequencies of about 15 to 110 Hz, the spectrum is now very 

flat, and the notch that was very noticeable at 40 Hz is much less apparent.  
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The spectral content of the data appears to be nicely whitened and flat 

throughout 15-110 Hz. 

Now that I have phase matched the two patches, applied surface-

consistent deconvolution and noise attenuated the data, I continue with velocity 

analysis on a 40x40 inline-crossline increment grid.  The flow for “velo-40x40” is 

identical to the flow for “velo-80x80”, with a few exceptions.  I have added a 

second Apply Residual Statics after the first one to apply SPWR0001 and 

RPWR0001 after the 80x80 calculation.  I change 3D Supergather Formation 

from an 80x80 grid to a 40x40 grid, leaving the minimum and maximum center 

inline and crossline the same.  I change the velocity guide function from “velo-

brute” to “velo-80x80” in Velocity Analysis Precompute, and name the output 

“velo-40x40-pc”.  I run 3D Supergather Formation through Disk Data Output.  

Once this is finished, I turn them off and turn on Disk Data Input and Velocity 

Analysis.  I create a new table to store velocity picks called “velo-40x40” and 

change the guide function to “velo-80x80”.  For my first pass, I decide to turn off 

the NMO stretch mute by setting the maximum stretch percentage to 0.0, 

indicating to ProMAX that I do not want any stretch muting.  I run the flow and 

the interactive velocity analysis window appears. 

I begin picking velocities, first using the semblance panel as a guide and 

then fine tuning my picks using the constant velocity function stacks.  Once I 

have picked a few CMPs and saved the picks to “velo-40x40”, I return to the 

flow editor, leaving velocity analysis open.  I turn off Disk Data Input and 

Velocity Analysis and turn on Volume Viewer/Editor.  I switch the input volume 
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to “velo-40x40” and choose to display “stack-80x80” as the postack data.  I run 

the flow, and the Volume Viewer Cross-Section and Map windows appear.  I 

can click the lower button on the left hand side and I will see where the analysis 

points reside.  I continue picking velocities in the interactive picking window, 

using the button that looks like a bow and arrow to send my picks to the volume 

viewer.  I use the viewer to QC my picks, looking for places where my picks 

may be creating a non-realistic velocity field.  Once I am finished, I save my 

picks one final time and exit both the volume viewer and the velocity analysis 

window.  I can now go back and set an NMO stretch mute at 30% to check how 

the gathers look with a stretch mute. 

Now that the 40x40 velocity analysis is complete, it is time to calculate a 

new set of residual statics, so I create a flow called “11b-residual-statics-

40x40”.  The flow is identical to my previous residual statics flow with a few 

exceptions.  I am now inputting “scdecon-5g-iters” instead of “prelim-decon”.  I 

add a second Apply Residual Statics to apply SPWR0001 and RPWR0001.  I 

switch NMO correction to use “velo-40x40” and I write out “nmo-40x40” with 

Disk Data Output.  I switch 2D/3D Max. Power Autostatics to read in “nmo-

40x40” and I change the Run ID to 0002.  I then run the flow from the beginning 

through Autostatics.  Before continuing, I use DBTools to examine SPWR0002 

and RPWR0002, plotting both by X and Y coordinates just as before.  The 

residual statics for the sources are mostly between +/- 1.0 ms, as are the 

residual statics for the receivers.  I also open my “view-CMP” flow and read in 
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“nmo-40x40” to view with Trace Display.  Again, I see flat events from about 

200ms down to almost 1200ms with some hints of other events even lower. 

Once this is complete, I turn off the first half of the flow and turn on the 

second half, beginning with the Disk Data Input after Autostatics.  I input “nmo-

40x40” and change Apply Residual Statics to apply SPWR0002 and 

RPWR0002.  I make no changes to Stack 3D or Time-Variant Scaling from the 

flow “08b-residual-statics-80x80”.  I run the flow and wait for it to finish.  Once it 

is done, I open my “view-stack” flow and read in “stack-40x40” and display 

using the sort list “20-380(10):*/” to get inlines 20-380 incremented by 10 with 

all crosslines.  The stack is now beginning to look very nice.  I am really 

beginning to resolve the events in the zone of interest between 500-700ms 

nicely and the basement structure is becoming apparent.  I could still do better 

with my velocity picks in the shallow 100-250 ms range, but picking good 

velocities at shallow times can be very challenging.  It looks like I may be 

picking a little fast, but it is hard to tell. 

Although I am very pleased with the amount of noise reduction I have 

been apply to attain, I am still struggling with some groundroll and other types of 

noise.  To clean up the gathers further, I am going to write out my “scdecon” 

with all residual statics and NMO correction applied without a stretch mute as a 

SEGY file.  This SEGY file is then passed through a prestack structure-oriented 

filter that searches along dip using coherency to filter out problem areas.  I build 

a flow called “11c-NMO-gathers-out” containing Disk Data Input, Apply Residual 

Statics, Apply Residual Statics, Apply Residual Statics, NMO Correction, Trace 
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Display, and SEGY Output.  I first test with a single CMP and turn on Trace 

Display and turning off SEGY Output.  I apply SPWR0000, RPWR0000, 

SPWR0001, RPWR0001, SPWR0002, and RPWR0002 using the three Apply 

Residual Statics.  I set the stretch mute percentage to 0.0 in NMO correction 

and use “velo-40x40” as the velocity parameter file.  I run the flow and the CMP 

I selected appears in the display window.  Happy with the output, I return to the 

flow editor, change the read option to get all trace, turn off Trace Display, and 

turn on SEGY Output.  I set SEGY Output to save to disk and use the file 

browser to navigate to where I want to output the SEGY file and name it “prs-

nmo-no-mute.sgy”.  I then edit the EBCDIC header to contain information about 

the processing history and pertinent header locations such as the CMP x and y 

coordinates and the inline and crossline numbers.  I then execute the flow. 

Once the prestack structure-oriented filter is completed, I must reimport 

the data to ProMAX.  I build a flow called “11d-import-of-sof-gathers+rnmo”.  

The flow consists of SEGY Input, Inline Geom Header Load, Spike & Noise 

Burst Edit, Inline Sort, Trace Header Math, NMO Correction, Header Values, 

and Disk Data Output.  I set SEGY Input to read in a file saved to disk and use 

the file browser to navigate to and select the file I want to read.  I set the sort 

order to CMP and the maximum number of traces per ensemble to 186, the 

maximum CMP fold.  I do not need to overwrite any trace headers.  I set Inline 

Geom Header Load to match using valid trace numbers.  I set Spike & Noise 

Burst Edit to edit automatically spikes, using a spike detection threshold of 10 

times greater than surrounding samples with an operator length of 100 ms.  I do 
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not edit automatically noise bursts.  I set the primary sort key for Inline Sort to 

CMP bin number and the secondary key to AOFFSET.  I set the maximum 

number of traces per ensemble to 186.  I use Trace Header Math to create the 

header equation “NMO_APLD=1” to indicate that the incoming data has already 

been NMO corrected.  If this flag is not set, the reverse NMO correction will fail.  

I set the direction for NMO correction to inverse and the stretch mute at 0.0.  I 

select “velo-40x40” as the velocity parameter file.  I want to check that the 

headers have been properly preserved, so I used Header Values and dump 

“CMP, CMP_X, CMP_Y, ILINE_NO, XLINE_NO”, listing only the last trace in 

the ensemble.  I use Disk Data Output to create “scdecon-pssof” and set the 

trace sample format as 32 bit.  I then run the flow. 

I now have two more passes of velocity analysis and residual statics 

before I write out my final gathers for prestack time migration.  I build a flow 

called “12-velo-20x20” which will use a 20x20 inline-crossline increment grid.  I 

set the increment in 3D Supergather Formation to 20 for both inline and 

crossline and change the minimum center inline and crossline from 40 to 20.  I 

select “scdecon-pssof” as the input dataset for creating supergathers.  I applied 

the residual statics already when I wrote the data out as a SEGY, so I will not 

apply them again.  I then use AGC and Bandpass Filter, using the same 

parameters I have previously.  I change the velocity guide function to “velo-

40x40” in Velocity Analysis Precompute and set the maximum NMO stretch 

mute percentage to 0.0.  I then execute the flow. 
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I turn off 3D Supergather Formation through Disk Data Output and turn 

on Disk Data Input and Velocity Analysis.  I read in “velo-20x20-pc” using Disk 

Data Input.  I create “velo-20x20” as the table to store velocity picks in Velocity 

Analysis.  I change the guide function to “velo-40x40” and set the maximum 

NMO stretch mute percentage to 0.0.  I then run the flow.  The picking window 

appears and I begin picking velocities, saving as I go.  After I have picked a few 

velocities, I minimize the window and return to the flow editor.  I turn off Disk 

Data Input and Velocity Analysis and turn on Volume Viewer/Editor.  I set “velo-

20x20” as the input volume and “stack-40x40” as the displayed poststack 

seismic data.  I then execute the flow and the Volume Viewer Cross-Section 

and Map windows appear.  I then continue picking velocities as before, QC’ing 

picks with the viewer as I go.  Once I am done, I save my picks and exit.  I may 

choose to rerun Velocity Analysis with a 30% stretch mute to see how the 

gathers look with a stretch mute applied. 

I now build a flow called “12b-residual-statics-20x20”.  The flow consists 

of Disk Data Input, AGC, Bandpass Filter, NMO Correction, Disk Data Output, 

2D/3D Max. Power Autostatics, Disk Data Input, Apply Residual Statics, Stack 

3D, Time-Variant Scaling, and Disk Data Output.  I turn off the second Disk 

Data Input to the end of the flow.  I read in “scdecon-pssof” using Disk Data 

Input, followed by AGC and Bandpass Filter.  I set NMO Correction to use 

“velo-20x20” as the velocity parameter file.  I then use Disk Data Output to 

create “nmo-20x20”.  I then select “nmo-20x20” for 2D/3D Max. Power 

Autostatics and I change the run ID to 0003.  I then execute the flow.  Once the 



164 

flow has finished, I check SPWR0003 and RPWR0003 using DBTools.  I open 

my “view-CMP” flow and view the “nmo-20x20” gathers. 

Next, I turn off the first half of the “12b-residual-statics-20x20” flow and 

turn on the second Disk Data Input to the end.  I read “nmo-20x20” with Disk 

Data Input.  I then select “SPWR0003 and RPWR0003” in Apply Residual 

Statics.  I stack using Stack 3D and then use Time-Variant Scaling.  Then I 

create “stack-20x20” using Disk Data Output.  Once the flow has finished, I view 

the stack using my “view-stack” flow. 

I build the final velocity analysis flow, which I call “velo-10x10”.  The flow 

is identical to “velo-20x20”, except I insert an Apply Residual Statics after 3D 

Supergather Formation.  I change the minimum center inline and crossline 

number to 10 and the inline and crossline increment to 10.  I also change the 

maximum center inline to 390 and the maximum center crossline to 190.  I 

apply SPWR0003 and RPWR0003 using Apply Residual Statics.  I AGC and 

use Bandpass Filter.  I select “velo-20x20” as the velocity guide function for 

Velocity Analysis Precompute.  I set the maximum NMO stretch mute 

percentage to 0.0 to turn it off.  I then create “velo-10x10-pc” with Disk Data 

Output and run the first part of the flow. 

Once the first part has finished, I turn off 3D Supergather Formation 

through Disk Data Output and turn on Disk Data Input and Velocity Analysis.  I 

read “velo-10x10-pc” using Disk Data Input.  I then create “velo-10x10” to store 

my velocity picks in Velocity Analysis.  I change the guide function to “velo-

20x20” and set the stretch mute to 0.0.  I then run the flow and the velocity 
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analysis window appears.  I begin picking velocities, saving as I go.  The 10x10 

grid will take some time.  I am picking inlines 10 to 390, incremented by 10, and 

crosslines 10 to 190, incremented by 10.  This translates to picking 741 CMPs.  

Once I have picked a few CMPs, I return to the flow editor and turn off Disk 

Data Input and Velocity Analysis and turn on Volume Viewer/Editor.  I select 

“velo-10x10” as the input volume and use “stack-20x20” as the poststack 

seismic data.  I then run the flow and the Volume Viewer Cross-Section and 

Map window appear.  I continue picking velocities and QC the picks using the 

volume viewer windows.  Once I have finished picking, I save the picks and exit. 

Next, I build the final residual statics flow called “13b-residual-statics-

10x10”.  The flow is identical to “12b-residual-statics-20x20” except I insert an 

Apply Residual Statics after the first Disk Data Input.  I read in “scdecon-pssof” 

and apply SPWR0003 and RPWR0003 using Apply Residual Statics.  I use 

AGC and Bandpass Filter with the same parameters I have previously.  I then 

select “velo-10x10” as the velocity parameter file for NMO Correction.  I write 

out “nmo-10x10” using Disk Data Input.  I then read in “nmo-10x10” for 2D/3D 

Max. Power Autostatics and change the Run ID to 0004.  I then run the flow.  

Once it is finished, I use DBTools to examine SPWR0004 and RPWR0004.  I 

then use my “view-CMP” flow to inspect the “nmo-10x10” gathers. 

I then turn off the first half of the flow and turn on everything from the 

second Disk Data Input to the end.  I select “nmo-10x10” for Disk Data Input.  I 

apply SPWR0004 and RPWR0004 using Apply Residual Statics.  Next, I use 

Stack 3D and Time Variant Scaling with the same parameters I have previously.  
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I then create “stack-10x10” with Disk Data Output and select 32 bit for the trace 

sample format.  I then execute the flow.  Once it is finished, I use my “view-

stack” flow to display “stack-10x10”. 

I am now ready to write out the final CMP gathers for prestack time 

migration.  I build a flow called “14-final-gathers-out” consisting of Disk Data 

Input, Apply Residual Statics, Apply Residual Statics, True Amplitude Recovery, 

TV Spectral Whitening, Time-Variant Scaling, Bandpass Filter, and SEGY 

Output.  I select “scdecon-pssof” in Disk Data Input and set the trace read 

option to get all traces.  I apply SPWR0003, RPWR0003, SPWR0004, and 

RPWR0004 using the two Apply Residual Statics.  I set True Amplitude 

Recovery to apply a spherical divergence correction using a 1/distance basis 

and select “velo-10x10” as the input velocity parameter file.  I do not apply any 

other corrections.  I then reapply TV Spectral Whitening and specify 10, 18,110, 

and 120 Hz for spectral balancing.  I then use Time-Variant Scaling, followed by 

a final Bandpass Filter, both using parameters I have selected in previous flows.  

I then set SEGY Output to save to disk and use the file browser to navigate to 

where I want to output the file, also giving the output file a name.  I edit the 

EBCDIC to reflect pertinent information about the output SEGY file.  For 

example, I include the processing history, the range of CMP numbers, inline 

and crossline numbers, the CMP bin size, the CMP X and Y coordinate origin, 

the azimuth, and byte locations for important trace headers.  I then execute the 

flow. 
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The final step is to output my “velo-10x10” velocity file as a SEGY.  

However, I want to interpolate the grid to a 1x1 inline-crossline increment so I 

can use it for prestack time migration.  I create a flow called “14b-final-velocity-

out” and it consists of Volume Viewer/Editor, Trace-Vel Table Transfer, and 

SEGY Output.  I turn off Trace-Vel Table Transfer and SEGY Output, leaving 

only Volume Viewer/Editor on.  I select “velo-10x10” as the input volume and 

“stack-10x10” as the poststack seismic data.  I then execute the flow. 

Once the viewer windows appear, I first click File > Save Active Volume 

To and call the volume “velo-10x10-interp”.  Next, I click Edit > Grid/Smooth 

Volume.  I set the increments for inlines and crosslines to both be one and set 

the time increment to 30 ms.  I then set the minimum and maximum inline and 

crossline values and the minimum and maximum time.  I then click “Apply”, and 

after a few moments, the volume is now re-gridded at a 1x1 inline-crossline 

increment and 30 ms time increment.  Next, I set the smoothing parameters for 

both inline and crossline to three to match my supergather smash.  I click 

“Apply” and then I click “OK”.  Once this is finished, I click File > Save Active 

Volume and then I exit.  I can then check the table “velo-10x10-interp”, which 

now contains picks at every CMP and every 30 ms. 

I turn off Volume Viewer/Editor and turn on Trace-Vel Table Transfer and 

SEGY Output.  I set the transfer direction to transfer a velocity table to trace 

data, and then I select to read an RMS parameter file.  I select “velo-10x10-

interp”.  I set the start time to 0.0 ms, the sample interval to 2.0 ms to match my 

seismic data, and the maximum time to 2000.0 ms.  I then set SEGY Output to 
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save a disk image and use the file browser to navigate to where I want to save 

the file, giving it a name as well.  I then edit the EBCDIC header in a similar 

fashion as before, but this indicating that the file is an RMS stacking velocity 

field interpolated for every CMP.  I then execute the flow, and now I am done 

with ProMAX until I want to do residual velocity analysis after prestack time 

migration. 


